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ABSTRACT 

ROTH, Ellen Cristina Wolf. Urban growth forecast using segmented and 
complete maps with the SLEUTH simulator. 2019. 99 p. Dissertation (Master 
Degree in Computer Science) - Federal University of Technology - Paraná. Ponta 
Grossa, 2019. 

Commercial, industrial and public administration activities depend on projecting how 
cities will evolve. One of the main characteristics of a city is its internal complexity, 
which makes it difficult to make any planning that depends on their understanding. 
Computational simulation, exemplified by the growth model SLEUTH, is a possible way 
to help the study of this problem. Its usage, however, depends on multiple data source 
and several parameters that have an impact on the quality of results. The objective of 
this dissertation was to perform simulation studies of the city of Ponta Grossa - Brazil, 
using the SLEUTH model, and analyze its behavior under the use of different 
parameters and approaches for data input. Experiments were planned according to 
different partitioning of the data; simulations were performed with each of the scenarios 
constructed, and the outputs were compared. Till the Final calibration, it was possible 
to observe that the model adapts to the way the city growths, although the outputs 
indicated a smaller expansion than expected; but the prediction results were lower than 
expected. One of the regionalization schemes presented a slightly better performance, 
but very near to the other approaches used, not justifying the time to spend in the 
calibration process. The results are analyzed and possible explanations, involving the 
model and the data, were discussed. 

Keywords: Urban simulation. Cellular automata. Cities. SLEUTH. 

  



RESUMO 

ROTH, Ellen Cristina Wolf. Previsão de crescimento urbano usando mapas 
segmentados e completos com o simulador SLEUTH. 2019. 99 f. Dissertação 
(Mestrado em Ciência da Computação) - Universidade Tecnológica Federal do 
Paraná, Ponta Grossa, 2019. 

Atividades comerciais, indústrias e de administração pública dependem da projeção 
de como as cidades vão evoluir. Uma das principais características de uma cidade é 
a sua complexidade interna, o que dificulta o desenvolvimento de planos que 
dependem do seu entendimento. Simulação computacional, exemplificada pelo 
modelo de crescimento urbano SLEUTH, é uma forma possível de ajudar no estudo 
deste problema. Sua utilização, porém, depende de múltiplas fontes de dados e 
diversos parâmetros que têm impacto na qualidade dos resultados. O objetivo desta 
dissertação foi realizar estudos de simulação na cidade de Ponta Grossa - Brasil, 
usando o modelo SLEUTH, e analisar o seu comportamento utilizando diferentes 
parâmetros e abordagens para os dados de entrada. Experimentos foram planejados 
de acordo com diferentes particionamentos dos dados; simulações foram executadas 
com cada um dos cenários construídos, e os arquivos de saída foram comparados. 
Até a calibração Final, foi possível observar que o modelo se adapta a forma que a 
cidade cresce, porém os arquivos de saída indicam uma expansão menor do que 
esperado, mas os resultados de previsão foram menores do que esperado. Um dos 
esquemas de regionalização apresentou um desempenho levemente melhor, mas 
muito perto das outras abordagens, não justificando o tempo a ser gasto no processo 
de calibração. Os resultados foram analisados e possíveis explicações, envolvendo o 
modelo e os dados, foram discutidas. 

Palavras-chave: Simulação urbana. Autômatos celulares. Cidades. SLEUTH. 
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1 INTRODUCTION 

Understanding, organizing and planning cities are tasks of high complexity: 

there are countless processes occurring inside a city, involving factors and parameters 

from diverse sources as economics, demography, geological conditions or politics.  

Small changes in city management may have impacts on bigger scales. A 

simple example is the organization of public transportation. The bus routes and 

stations are usually defined with respect to strategic points as streets situation, the 

area covered and the number of users. Modification to routes will impact users and 

likely alter their schedulers, but may also have an impact on the commercial 

development of a region, as stores and markets are attracted to places more easily 

accessed by population. 

The location of healthcare centers, police stations and other public facilities 

depends on characteristics as population density, social and medical statistics. The 

choice of the placement of such centers will influence the decisions on public 

transportation and, at the same time, are affected by that system. 

Commercial and industrial activities, representing the private sector, add other 

variables to this context. For instance, the installation of new industries may attract the 

development of residential areas and increase the population density of a region. This 

may cause movements inside of a city, with impacts on all the processes already 

mentioned: distribution of commerce, creation of bottlenecks in transports and other 

functions or, inversely, emptying of areas where investments were made by the 

municipality. 

The context becomes even more complicated due to exogenous factors. As 

an example, in the city of Ponta Grossa, the arrival of enterprises as DAF, Continental 

and Crown were driven by global economic factors. The arrival and installation of such 

enterprises depends on decisions and information that can fall outside the scope of 

what is analyzed in the administration of a city.  

As another example, Brazil major political and economic crisis in 2016 resulted 

in the shutting down of several businesses in Ponta Grossa; meanwhile a new private 

university announced its presence and in a short delay built its installations in a region 

where real state had relatively low cost. This will have a probable impact on the 

development of commerce and increase in the value of properties, which could not be 
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predicted in view of the history of the region alone during the last decade, neither on 

the recession affecting the whole country. 

Administrators dispose of tools, as management plans, databases, maps and 

routine administration software, but generally these tools present a static nature. 

Projections are generally based on linear regression used to draw curves of population, 

preview budgets and so on, with simple models that do not take into account 

interferences between multiple data sources. Reconstruction of lacking data is done in 

the same way, meaning that answers about data are based on data itself and not on 

the processes that generates the numbers. An example of this would be the projection 

of the approximate population of a city in periods where the census is not conducted. 

Computational simulations may be an invaluable method in this context, 

helping to understand the reasons that drive certain phenomena, and, to a certain 

extent, to foresee scenarios and consequences of human actions and decisions, 

allowing early interventions and possibly higher precision.  

Simulators can be effective tools for urban planning, making it possible to test 

different scenarios. An example is the organization of traffic signs, which, thanks to 

simulation, has the potential to quickly predict the behavior of a transport system and 

possibly mitigate problems as bottlenecks. 

Of course, all the potential benefits of simulation studies do not come without 

costs and shortcomings. The theoretical reconstruction of a phenomenon or object, 

involves the modeling of variables, processes and relationships. By means of 

simulation, we are able to explore the model itself and the world it represents 

(CLARKE, 2014). This way, the study of urban systems makes it possible to better 

understand the consequences of individual level choices at a global level. As this is 

one of the main objectives in system studies, simulation creates the possibility of 

finding links between the macro and the micro scales (BENENSON; TORRENS, 2004). 

In many natural systems, having a mechanical understanding of how a certain 

phenomena work and representing this knowledge with mathematical equations and 

models, is enough to simulate its behavior with precision. But in urban systems, this is 

not enough, as it involves human behavior and a bit of randomness (ALLEN, 2012). 

Cities are complex emergent systems; they are adaptive and dynamic, with 

complicated relations between microscopic and macroscopic behavior. Dividing this 

kind of system into smaller and simpler modules helps to understand and observe the 
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interactions of the entities (HOEKSTRA; KROC; SLOOT, 2010; BENENSON; 

TORRENS, 2004). 

The study of cities has resulted in a certain number of modeling and simulation 

techniques, especially in the field of urban growth and land use. As urban systems are 

very complex and their attributes are often influenced by different characteristics within 

the system, it is important to note that sometimes models can have different results 

than reality. Models are simplified forms of reality and their characteristics may not be 

able to fully simulate the reality being studied. 

Cellular Automata (CA) are mathematical models, based in a grid of cells which 

evolves in discrete time and states, using rules (DOWNEY, 2018; WOLFRAM, 1983). 

CA models are used in several areas of science, including anthropological, historical, 

physical and biological contexts. They have a relatively simple construction that 

contrasts with the complexity of the systems that are studied with their help. They were 

already used in varied kinds of simulations as biological modeling (ERMENTROUT, 

1993), chemical reactions (SCALISE; SCHULMAN, 2016), microstructure evolution 

(QIAN; GUO, 2004), epidemics spread (WHITE; DEL REY; SÁNCHEZ, 2007) and are 

frequently employed in the study of cities. 

In urban simulation it is common to observe models that associate CA and 

Geographic Information Systems (GIS). Similar aspects may be found in both, the 

approaches are based in simple spatial interaction, and grid/cells representation can 

be related with raster-based (WAGNER, 1997). CA landscape input data may be 

drawn using GIS and the model output also may be represented using it (CLARKE; 

HOPPEN; GAYDOS, 1997; BATTY; XIE; SUN, 1999; LI; YEH, 2000). The use of both 

together overcome some limitations they have, while CA models handle with temporal 

dimension and spatial models, the GIS may help to define transition rules. (WHITE; 

ENGELEN 1997; PARK; WAGNER; 1997; LI; YEH, 2002) 

In Brazil, there is an extensive terrain to be developed, but this implicates in 

human commitment, exploration of the available studies, development of new models 

and tools, integration of systems and data gathering, and the change of a paradigm.  
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1.1 OBJECTIVES 

This project develops a simulation study of Ponta Grossa, employing a widely 

used tool called SLEUTH. Given the intrinsic difficulties surrounding model calibration 

and the validation of results, the central objective of the study is to compare two 

modeling approaches: a global simulation where the entire city is processed by the 

software, followed by a regionalization of the map with the separate simulation of each 

parcel. The hypothesis of the study is that the segmented approach can obtain a better 

calibration; consequently, forecasts would be more accurate. 

The main objective of the study is the comparison between modeling 

approaches: global or segmented. This involves the following goals: 

 preparation of all input, which may imply reconstruction or interpolation for 

non-available data (Figure 1); 

 carrying out the simulations, compiling and tabulating data; 

 performing quantitative and qualitative analysis of results. 

 
Figure 1 - Example of the construction of an urban spot using satellite maps overlaped 

 
Source: adapted from Google Earth and INPE 

 A few initial obstacles have been identified. One of the main ingredients for 

simulation and modeling - information in digital form - is not systematically collected 

and stored by public administration. Some data sources have been identified in the 

beginning of the work and are expected to satisfy the needs. One possible remedy to 

the problem is to make use of interpolations. A second concern is model calibration, in 

view of a possible lack of data: the less data available, the more sensible the simulation 
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will be to parameters. The regionalization of the city map is expected to ameliorate the 

results. 

 

1.2 ORGANIZATION 

In the next chapter the Urban Simulation problem will be discussed, followed 

by a section on the Cellular Automata model. After this, in Chapter 4, Cellular Automata 

in Urban Simulation and the SLEUTH model will be described. The development of the 

study is found in Chapter 5 and, finally, chapter 6 presents results and conclusions. 
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2 URBAN SIMULATION 

Deep changes are happening in geographical distribution and the size of the 

world population. The lack of urban planning is felt, as some places still lack of basic 

resources as sewage and piped water, and the traffic disorder is present in several 

places. The actions taken on a city have direct and indirect impacts on different 

aspects, from traffic organization to citizen’s security. Urban processes should be 

monitored and planned, aiming the sustainable development of the cities and the 

clever use of the available resources (SOUZA, 2002; DEEP; SAKLANI, 2014; 

TORRENS; O'SULLIVAN, 2000; KOURTIT; NIJKAMP, 2013; TEZA; BAPTISTA, 2005; 

BASTOS, 2007).  

Cities can be compared with living systems, composed of different sub-

systems, which are full of connections and complex interactions. Micro and macro 

interactions can shape city patterns and its evolution, and the system space and time 

are dynamics. The city is a complex system, and a first step to understand it is to study 

its subdivisions separately. Among these subdivisions, it can be cited the traffic sub 

system, urban growth, and land use (CROOKS, 2006; MEIER, 1962). 

One of the most important things to understand about a city is how it grows. 

This process has an important role in public administration; as an example, this 

information helps project the needs of new public resources, like transportation or 

healthcare centers, and project the extension of basic services as water and electricity 

supply. Predictions about urban growth are also crucial in the private sector, providing 

background for study of feasibility of new business establishments. Finally, it may help 

to understand changes in the social organization of a community (PARK; BURGESS, 

2012; BARROS, 2004). 

The way a city grows is not a universal process; although there are similar 

aspects in all cities, the exact evolution of each one follows different patterns (MA; 

HANTEN, 1981; CHENG, 2003; BASTOS, 2007; ROCHA, 2012). Social aspects also 

influence the evolution of a city in several ways; municipal elections are a simple, yet 

significative example (HAASE et al., 2012). Natural factors, such as possible flooding, 

and the transformations that happened through time also have impacts (POLIDORI, 

2005). Briefly, urban transitions are a result of physic, socioeconomic and 

environmental aspects that compose a complex system, full of different spatial and 
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temporal behaviors (CHENG, 2003; BOURNE, 1982; ROCHA, 2012). It is possible to 

use the same model for the different cities because the historical data of each of them 

show their development patterns and transitions, defining how the model will behave 

(SANTÉ et al., 2010). 

An urban system is formed by two different “worlds” (SIEBERT, 1999): the 

formal city and the not formal. The first correspond to the fraction that respects policies, 

gives origin to official data, pay taxes and remain within the laws imposed by the 

government. The second is the city where land is invaded, taxes are not paid and 

statistics and data are wrong or not available. These two different worlds have 

influence on the system development. 

All these characteristics make necessary for administrators, economists, and 

investors to have tools to help them understand the dynamics of a city and make 

decisions.  

Urban models are tools applicable in many tasks related to city planning. They 

may indicate environmental and social problems before they actually happen 

(FORMAN, 2008). City Traffic (SIMON; NAGEL, 1998), crime patterns (LIANG, 2001), 

evolution of land use patterns (WHITE; ENGELEN, 1993) and city growth (AL-

SHALABI et al., 2013). The analysis of model predictions brings the possibility of 

applying early intervention policies and adaptations, to mitigate negative effects, also 

may raise governmental and public awareness about social and physical aspects, and 

helps to address possible complications (BAYNES, 2009; FORMAN, 2008; PETROV; 

LAVALLE; KASANKO, 2009).  

The acceleration of the urban growth makes the study of this aspect one of the 

most important to be understood. Due this phenomenon in the recent history, planning 

and managing is becoming more complex. The expansion makes pressure on land 

resources, bringing environmental and social problems, which makes this kind of 

simulation significant (LIU et al., 2014; LEAO; BISHOP; EVANS, 2004; HEROLD; 

GOLDSTEIN; CLARKE, 2003).  

The most typical form of this kind of study represents land use changes along 

of a period of time. Figure 2 shows one example, with the land use model UGM (Urban 

Growth Model) applied in the city of Porto Alegre, Brazil. UGM is the principal module 

of the software SLEUTH, used in this project; the land-use changes are categorized 

by the transformation of not-urban areas, as farms or woods, represented by the color 
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white, in roads, buildings, and others urban forms, represented in black (CHENG, 

2003; LEAO; BISHOP; EVANS, 2004).  

 
 Figure 2 - UGM simulation of the urban growth of Porto Alegre - 2010 - 2050 

 
 Adapted from: Leao, Bishop and Evans (2004). 

Given the large scope of the problem, a number of techniques have been 

developed for the study of cities. It is worth to draw a historical perspective of how 

simulation evolved; this will be briefly discussed in the next section. 

 

2.1 THE HISTORY OF URBAN SIMULATION 

Possibly the first known model for city studies was developed by the German 

economist von Thünen, in 1826. It was a descriptive model for a region (as a fief) 

comprising an urbanized nucleus surrounded by farmlands. The model was a base for 

others approaches, as Hoover (1936) and Dunn (1954). The von Thünen model 

(Figure 3) considered three factors: the distance from the market, the goods price and 

the land rent. It was based on the hypothesis that the transportation cost and distance 

were inversely proportional to the land-use intensity (HENSHALL, 1970). 
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Figure 3 - The von Thünen model 

 

Source: adapted from Grotewold (1959). 

In 1909, Weber created the Industrial Location Model, extending von Thünen’s 

model to address the problem of urban growth. Following the work of Weber other 

studies were developed, as the Central Place Theory, by Christaller (1933) and 

Multiple Nuclei Model from Harris and Ullman’s (1945), but they did not take urban 

development into account to the same extent (LIU, 2008). 

Urban models were intensively used in the quantitative revolution1, in 1950s, 

and lasted till the late 1960s (BATTY, 1981). The major development of urban models 

was in North America, caused by the spread of the car owners (BATTY, 1976). The 

models were focused in operational decisions, as highway impacts and urban 

problems (PUTMAN, 2013; WADDEL; ULFARSSON, 2004). The models were used in 

transportation studies, to plan the needs and accommodate the demand, using as a 

base the people movement and the effects of the land use (FOOT, 2017). 

The development of computers made it possible to work with complex 

mathematical models and a set of styles, techniques and applications, dealing with 

problems as land use, transportation, population and urban economics. They were 

                                            
1 The Anglo-American geography transformation, in the 1950s and 1960s, when new ways of research 
were introduced in the area, as inferential statistical techniques, abstract models and new theories 
(GREGORY et al., 2011). 
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initially built using techniques as linear analysis and mathematical programming 

(KILBRIDGE; O’BLOCK; TEPLITZ, 1969). 

These studies were focused in modeling techniques, and researchers started 

to use mathematical tools to make qualitative analysis. This pattern last till the late 

1980’s, when the studies about complex systems gained attention and new ways to 

study cities were devised. In this period progresses also occurred in nonlinear systems 

and Chaos Theory. GIS (Geographical Information System) were developed, and 

made it possible to use improved data and new techniques for data analysis (ALLEN, 

1997; WEGENER, 1994; LIU, 2008). 

All the available tools, data and mathematical techniques lead to different 

simulation studies. It is important to identify, how each element, in this set of tools, can 

be useful to build a model. This will be examined in the next section. 

 

2.2 IMPORTANT FACTORS FOR URBAN SIMULATION  

Urban dynamics are composed of multiple processes and, as such, it can be 

influenced by many different events and parameters. The expansion of a city is one of 

these processes and depends on things as population growth, roads under 

construction, economy situation and infrastructure (SUDHIRA, 2004). One method to 

analyze this context is by identifying forces as repulsion and attraction that influence 

the urban growth and the definition of the land-use (DENDRINOS, 2002). An example 

of this are regions with higher costs per area act as points of repulsion to the 

occupation by productive sectors (manufacture, industry), who prefer to have 

installations in regions as suburbs that can maximize the return on investments. 

Residential and commercial areas are also related, and function as a probabilities 

system, increasing and decreasing the potential of the locations (KRAFTA, 1999).  

The space distribution and classification of areas according to the usage is one 

of the first factors affecting urban dynamics (SPINELLI; KRAFTA, 1998). Residential 

areas are usually created in the vicinity of other residential areas, giving the possibility 

of extending the infrastructure already existent. Commercial activities and the 

availability of access routes are other factors that function as attractors. Proximity to 

industrial areas, on the other hand, generally represent an inhibitor for the construction 

of residences, although this situation can be balanced by the attractive advantages 
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already listed (ALMEIDA, 2003; BARREDO, 2003). As it happens with residential 

areas, industrial areas growth is impacted by the road accessibility and the proximity 

to other areas with the same type of occupation (BASTOS, 2007). Growth saturation 

at the center of the cities may cause a shift of activity to peripheral areas (SAURIM, 

2005), something known as ‘decentering’ (BURGA, 2009). 

The existence of parks, rivers, airports, roads and transportation may affect 

the future occupation of areas; “dead” spaces, which cannot be urbanized, soil 

particularities and regulations regarding allowed activities can have influence over the 

transitions (WHITE; ENGELEN, 1997; PEDROSA, 2003; GRANERO; POLIDORI, 

2002; SAURIM, 2005). Social factors, as development politics, may be considered in 

some models too (BASTOS, 2007). 

Macroscopic properties, as the placement of residential areas or the 

distribution of population, may have a strong dependency on microscopic structures of 

a city, as the network of local commerce, employment opportunities. Each level of the 

system can have been affected by what happens at the lower scale structure. This 

reveals that the different system levels are local and global phenomena at the same 

time, the system as a hole is dependent of the individual's actions, and the global is 

not predominant over the local neither the local over the global (ROCHA, 2012). This 

relation between the micro and the macro scale can enter models of land-use 

dynamics, which may show as the decisions on both scales work together. (LAUF et 

al., 2012).  

Small modification in the initial data may be amplified over time making system 

predictions harder, a phenomenon popularly known as butterfly effect. As an example, 

a single investor that opens a new business may encourage similar initiatives that, over 

time, may change the characteristics of a neighborhood. By observing how small 

modifications on initial conditions can lead to big changes in the system future, it is 

possible to understand future possibilities, explore the influence of the variables in the 

process, and create strategies to administer the urban growth (ROCHA, 2012). 

Another relevant modeling aspect is the fact that processes occurring 

simultaneously in a city may have different time scales. For instance, traffic conditions 

depend on the hour and day of the week, while cycles as increase or decline of 

population, changes in buildings construction and development of neighborhoods may 

take years to have significant changes (ROCHA, 2012). Integrating processes that 

operate in very different temporal and spatial scales occurs in many branches of 
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science and is a problem on its own (HOEKSTRA et al., 2010). Most simulators, to our 

knowledge, model cities using processes that occur at the scale of years. The diversity 

of parameters, rules, data sources, and non deterministic aspects compose a 

challenging task. The expansion of urban areas is, on first sight, a chaotic process, 

encompassing several types of events and phenomena happening simultaneously. 

However, a more detailed examination may reveal the presence of patterns in the 

system, simplifying its understanding (SAURIM, 2005). This point in the direction that 

the difficulties can be mitigated by breaking the system down into modules or elements 

(POLIDORI, 2005). 

As it can be seen the study of cities is a rich field of investigation, what has 

resulted in many modeling approaches. They include mathematical representations, 

techniques to incorporate human behavior and techniques as fractals that were born 

from the field of complexity. The next section overviews some of the possibilities.  

 

2.3 MODELING APPROACHES 

Digital maps, although being crucial, are only the initial information required to 

model a city; it is also necessary to find representations for the forces and dynamic 

processes that arise in the system (BATTY; STEADMAN; XIE, 2006). There is a variety 

of techniques to urban simulation models, ranging from the traditional models, like 

mockups, to mathematical-based representations. They can be classified according to 

attributes as the degree of simplification, and construction style.  

The simplest category is Scale models, consisting of miniatures or mockups 

with some transformations. An intermediate level is occupied by Conceptual models, 

focused in components and their relationships; they can be expressed in diagrams and 

verbal language. Lastly, the more complex category contains various types of 

Mathematical models. Which have subclasses, depending on its characterization; they 

could be descriptive, static, dynamic, stochastic, among others (THOMAS; HUGGET, 

1980; LIU, 2008). The following section will make an overview of three modeling 

techniques that are frequently found in the literature about urban simulation. 
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2.3.1 System Dynamics 

System Dynamics (SD) models allow the partition of a simulation into three 

subsystems: business, housing and population, and also allows the inclusion of socio-

economic aspects (SANDERS; SANDERS, 2004). Basically SD models are composed 

by stocks and flows. They can represent interdependencies and interactions of local 

systems. Models can have nonlinear responses, irreversible changes and long lag 

times (THEOBALD; GROSS, 1994). They have the ability to work with large sets of 

temporal data and include explicit feedback loops in the simulation (HAASE et al., 

2012; STERMAN, 2000). 

SD models are not spatially explicit; in other words, these models do not 

consider a map of a city and can not calculate results related to locations. Instead, their 

behavior is described by differential equations and functional relationships that have a 

more global character and that can change during the simulation. SD can use “what-if 

scenarios” and predict changes in complex systems, being an option to support 

recommendation and examination of policy decisions (HAASE et al., 2009). 

This kind of model is able to simulate social-demographic changes and also 

urban shrinkage (HAASE et al., 2012). Reported applications include landscape 

change simulation (DHAWAN, 2005; STERMAN, 2002) and land-use changes (LI; LIU, 

2007). However, it cannot handle spatial variables, which can influence the land-use 

change, and also is not capable of revealing spatial pattern changes (HAASE et al., 

2012). 

Other examples where SD models have been used include: 

 Forrester (1970): a general model was constructed by connecting 

subsystems "business”, "housing" and "population". This model could 

simulate situations as rapid population growth; 

 Haghani, Lee and Byun (2003): transportation and land-use were combined 

with the objective of estimating scenarios; transport policies were used as a 

base tool; 

 Eskinasi and Rouwette (2004): a SD model aimed in analyzing the impact 

of future policy interventions impacts on the social housing market. 
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2.3.2 Agent-Based Models 

The word “agent” has countless definitions in the literature and trying to obtain 

a consensus is out of the scope of this study. The relevant aspect to consider here is, 

agent based models (ABM) refer to the idea of representing individual decisions and 

actions that may be relevant in a given urban simulator (EPSTEIN, 1999). 

Models in this category are usually spatially explicit, with maps describing the 

land characteristics (DUNNING et al., 1995), and may include autonomous decision-

making individuals. Each individual can have different properties and strategies 

(BONABEAU, 2002; SAWYER, 2003; PARKER et al., 2003), what can be valid, for 

example, to study micro-scale phenomena in transport systems (HAASE et al., 2009). 

Another example where modeling the perspective of individuals is a 

reasonable approach, is to simulate social processes, as the development of a 

residential area by an artificial society (LI; LIU, 2007; LIGTENBERG; BREGT; VAN 

LAMMEREN, 2001; HAASE et al., 2009; LE; SEIDL; SCHOLZ, 2012). 

Some general examples of the application of these ideas are (HAASE et al., 

2009): 

 ILUMASS, by Strauch et al. (2005): a model focused on urban traffic, that 

also includes activity behaviors, land use changes and effects on the 

environment; 

 Ettema et al. (2007): a model built to predict urbanization using behavioral 

agent; 

 Miller et al. (2004): the model simulates evolution of a region focused on 

transportation; 

 Wadell et al. (2003): the tool UrbanSim analyzes the impact of distinct 

planning strategies, linking transport and land use. 

2.3.3 Cellular Automata 

Cellular Automata (CA) is a modeling technique with a broad spectrum of 

application, ranging from fluid dynamics to social sciences. One of main characteristic 

of this model is the use of a grid of cells, representing the global behavior of the system 

that emerges from local rules (COUCLELIS, 1985; FANG et al., 2005). 
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The execution of CA models can lead to complex patterns that result from the 

application of simple individual rules (ROCHA, 2012), a concept viewed as very 

amenable to urban simulation (CLARKE; GAYDOS, 1998; BATTY, 1997). 

CA is probably the most widely adopted technique in the field of urban 

simulation, being simple to understand and to use, and at the same time, flexible 

enough to accommodate complexity without compromising the understandability of the 

model itself. This technique was chosen in this work and will be detailed in the next 

chapter. 
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3 CELLULAR AUTOMATA 

Cellular automata (CA) are simple and dynamic models of physical systems, 

with discrete time and generally discrete states. A model based on CA divides space 

into discrete units (cells), which are governed by rules that define how the system must 

evolve. Although having a simple structure, a CA model is capable of generating 

complex patterns in the system’s evolution (DOWNEY, 2018; WOLFRAM, 1983). 

CA models have some properties in common. They are composed of a matrix 

or grid of cells that evolves in discrete steps of time; each cell has a state among a 

finite set of possibilities; cell evolution is dependent of the state of neighbor cells; and 

the neighborhood relation is uniform and local (WEIMAR, 1997). 

Figure 4 shows an example where a CA model is used to represent the 

structure of a galaxy, based on a percolation process (SCHULMAN; SEIDEN, 1986; 

SCHIFF, 2011). This study is a sound example of how a CA model can be used to 

capture the most significant aspects of a phenomenon and replicate the general 

properties and behavior of a system.  

 
Figure 4 - Simulation of a Spiral Galaxy using the CA Model 

 

Source: Schulman and Seiden (1986). 

CA models have been given different names, such as "cell structures", "mosaic 

automata", "homogeneous structures" and "interactive arrangements”. (SANTÉ et al., 

2010). One of the principles of CA is that the local transition function determines the 

current state of individual cells based on what occurred in the previous step. Since 

rules are local, each cell works as an information processing unit. The neighborhood 

is usually defined as the immediate adjacent cells. As a consequence, in such 
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organization a cell always influences the behavior of the others in the evolution of the 

system and the result of each interaction has an impact on the next steps of the model 

(VIANA et al., 2014). 

Complex systems can be defined by properties as emergence, self-organization 

and nonlinear dynamic behavior (SCHALDACH et al., 2011; BERLING-WOLFF; 

JIANGUO, 2004; BARREDO et al., 2003; RAVETZ, 2000). These aspects can be 

perceived in the CA models by the following characteristics: creation of complex 

patterns, that indicate non-linearity; interaction in micro scale reflection on the global 

system, showing self organization; and the impossibility to define the future model 

states, just observing the past ones, revealing the model emergence (VIANA et al., 

2014; ROCHA; MORGADO, 2007). 

Cells can be grouped in different ways and be controlled by different rules; in 

an extreme case, each cell can have its own set of rules. In addition to these 

characteristics, the spatial representation of entities and relationships between cells 

allows to create different types of grids and different configurations to be used for 

system modeling (ROCHA, 2012). Most CA models follow these fundamental 

characteristics (SCHIFF, 2011):  

 uniformity: the cells update follow the same rules; 

 synchronism: the update of all cells happen at the same time;  

 locality: the rules are local. 

Classic CA models are organized as one-dimensional, which can be visualized 

in Figure 5, that represents the evolution of a one dimensional automaton where the 

cells change according to the colors of its neighbors; or bi-dimensional.  

 
Figure 5 - Vertical sequence of states of a one-dimensional Cellular Automata 

 

 Source: Wolfram (2002). 

Simulations based on CA models can show behaviors varying from very simple 

to very complex. A classification of automata based on those behaviors was proposed 
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by Wolfram (1983), and has four categories or classes (Figure 6) (ILACHINSKI, 2001; 

DOWNEY, 2018; FERREIRA, 2009): 

 Class I: deterministic; after a finite number of steps, evolve to a 

homogeneous and stable state; 

 Class II: slightly random; initial patterns evolve into stable and oscillating 

structures. The pattern contains structures of its own in miniature; 

 Class III: exhibit pseudo randomness; evolves into chaotic states. Models 

in this class have great dependency on initial conditions, and small 

variations can lead to strong instability; 

 Class IV: can be considered Turing Complete; evolves into structures that 

interact in complex ways and create local patterns that can survive for long 

periods of time. 

 
Figure 6 - Wolfram Classes 

 
Source: Avnet (2000). 

AC models may be deterministic, when their behavior can be represented by 

a finite state machine; and probabilistic, when transition rules are associated with 

probabilities (SIMÕES, 2016). 

 

3.1 CELLULAR AUTOMATA HISTORY 

The most accepted origin of Cellular Automata is the combination of the works 

of John von Neumann and Stanislaw Ulam in 1942. John von Neumann was working 

on a model of self-reproducing organisms. Stanislaw Ulam, who studied crystal growth 

(PICKOVER, 2009), simplified the von Neumann model into a 2-dimensional cellular 

automata. Von Neumann believed that a complex model was needed to represent 

varied behaviors, so he used a large number of cells, each of them could have 29 

colors and complicated transition rules (WOLFRAM, 2002). 
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CA models became popular with the introduction of Conway’s Game of Life, in 

1970; this two-dimensional model simulated a colony of simple organisms. Each cell 

had two states, 1 - alive and 0 - dead; the transition rules depended on the 8 neighbor 

cells as represented in Chart 1. In Chart 1, the target cell, which is being updated, is 

represented by the yellow cell; the living cells by the blue dots; and the dead cell by 

the x symbol (FERREIRA, 2009; SCHIFF, 2011): 

 
Chart 1 - Game of Life Rules 

Rule Matrix configuration 

a living cell, remains alive if it has two or three 
living neighbors 

 
 

a living cell, dies of loneliness, if it does have 
just one living neighbor 

 

a living cell, dies of overpopulation if it has 
more than three living neighbors 

 

a dead cell, becomes alive if it has exactly 
three neighbors 

 

if none of the previous cases occurs, the cell 
remains dead 

 

Source: adapted from Benenson and Torrens (2004). 

The execution of the game caught attention of researchers. Certain cell 

group’s exhibit periodic behavior and are known as "blinkers". Other groups seem to 

travel through the matrix and are known as “gliders”. It is also possible to observe that, 

regardless of the initial configuration, there are three possible states that the system 

can achieve (FERREIRA, 2009): 

 extinction: all model cells die; 

 stability: the model reaches an unchanging state; 

 oscillation: the model cycles through a sequence of two or more states. 
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3.2 NEIGHBORHOOD 

The neighborhood is one of the fundamental characteristic of any CA model. 

It corresponds to a set of cells, chosen according to spatial and temporal criteria, which 

will be taken as input by the transition rules of a given cell (HADELER; MÜLLER, 2017; 

COLOMBO, 2011; DEUTSCH; DORMANN, 2005; ZHAO; BILLINGS, 2006; PINTO; 

ANTUNES, 2007). 

The cell that’s going to be updated may or may not be part of its own 

neighborhood. The neighborhood can include cells that do not have direct contact with 

the one being analyzed. It is possible to weight the influence of neighbors according to 

their distance. The neighborhood can be asymmetric (DAHAL; CHOW 2015), although 

symmetric ones are the most usual (CARTWRIGHT, 2008; MAEDA; SAKAMA, 2007). 

In one-dimensional models the cell grid is frequently considered as infinite; in 

this case the neighborhood is usually composed by left and right cells. This kind of 

neighborhood is known as Radial (Figure 7). 

 
Figure 7 - Radial Neighborhood 

 

Source: adapted from Maeda and Sakama (2007). 

Two dimensional grids are the most usual, and have some neighborhood 

configurations that are known by particular names. The most used 2-dimensional 

neighborhoods are the Von Neumann (Figure 8a) and Moore (Figure 8b), containing 

cells that have direct contact with the cell being updated. As more cells are added it 

results the r-Radial, or Von Neumann extended (Figure 8c), and r-Axial, or extended 

Moore (Figure 8d) (DEUTSCH; DORMANN, 2005). 

 
Figure 8 - (a) Von Neumann's neighborhood; (b) Moore's neighborhood; (c) r-Radial 
Neighborhood; (d) r-Axial Neighborhood 

 

Source: Adapted from Maeda and Sakama (2007), Deutsch and Dormann (2007). 
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A quite different neighborhood is the so-called Morgolus, which have the 

following characteristics (SPEZZANO; TALIA, 1999; COLOMBO, 2011): 

 Finite and uniform set of cells, forming a 2x2 block; 

 Transition rules are applied to the blocks, not to the individual cells; 

 No information is exchanged between adjacent cells; 

 Two types of neighborhood configuration are used; they alternate between 

even and odd steps. 

These characteristics can be visualized in Figure 9, where the blue cells are 

the neighbors of the red cell. The set of cells forms a block, which behaves in the even 

step as Figure 9a, and in the odd step as Figure 9b. 

 
Figure 9 - Neighborhood of Margolus (a) Even - (b) Odd. 

 

Source: adapted from Colombo (2011). 

 

3.3 TRANSITION RULES 

Transition rules, or transition functions, are the most important aspect of CA 

models. They determine the system evolution; define local patterns and how the 

system works. The definition of rules depends, among other factors, on the geometry 

of the grid, the type of neighborhood and the available states (WEIMAR, 1997; 

SCHIFF, 2011; TORALLES, 2013; SIMÕES, 2016). 

Some works apply a classification to rules, similar to what is done with 

neighborhoods, although the nomenclature is not as standardized. Some examples 

can be cited: 

 Totalistic: the next state depends on the sum of the states of the 

neighborhood cells; and External Totalistic rules, which also consider the 

cell being updated (SIMÕES, 2016; ILACHINSKI, 2001); 
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 Additives: use linear functions of the neighborhood cells (ILACHINSKI, 

2001); 

 Multiple Steps: rules are divided into sub-steps (SIMÕES, 2016); 

 Probabilistic: are evaluated according to calculated probabilities (WEIMAR, 

1997). 

Traditionally, transition rules are fixed along the simulation and are applied to 

all the cells in the grid. In general, the major changes made in the classic CA model 

are in the form that transition rules are created (TORRENS; O'SULLIVAN, 2000); some 

examples include characteristics as hierarchy, self-modification, probabilistic 

expressions, exogenous links, weights and randomness.  

The rules used in CA models for city simulation can be derived using automatic 

procedures, although this is not a common solution (LIU et al., 2007). Li and Yeh (2001) 

proposed a model that uses Neural Networks to define transition rules, requiring 

information only for simulation training. Feng et. al. (2011) used the Particle Swarm 

Optimization to improve transition rules identified by statistical methods. Other forms 

of discovery include the Ant Colony algorithm (LIU et al., 2007) and a variation of the 

concept (YANG et al., 2013). 
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4 CELLULAR AUTOMATA IN URBAN MODELLING 

Cellular automata are dynamic spatial models, which can describe the 

evolution patterns of a system through time. They are able to reflect the complexity of 

systems being studied, mimic their behaviors and help to understand them 

(BENENSON; TORRENS 2004).  

The components of a System can be divided into three categories (ROCHA, 

2012): 

 elements: constitutes the system (i.e. as sand grains on the beach); 

 attributes: the elements characteristics (i.e. color or size); and 

 relationships: the associations between elements and attributes. 

Most of the systems have common characteristics: structure defined by parts 

and processes; reality generalizations; the tendency of generating patterns, depending 

on the inputs, outputs and the process to be transformed; and the functional and 

structural relations (ROCHA, 2012). 

In a city the relation between the man-made, the social and the environmental 

components frame the complexity and the dynamic of the system (KASANKO et al., 

2006). The emergence on the concept that urban systems are almost critically self 

organized, but far from equilibrium, given its behavior, as the components are 

constantly changing, but the city itself remains in its place (ROBERTS; KANALEY 

2006; BAI, 2007; GRIMM et al. 2008; BAYNES, 2009). 

An urban model represents the city so that its aspects and relations can be 

easily understood, and this may aggregate new information to complexity studies. 

Mathematical and theoretical models have been used aiming the reduction of the 

intricacy of urban aspects, to overcome the challenge of the development of urban 

models (POLIDORI, 2005; HAINES-YOUNG; PETCH, 1986; WADDELL; 

ULFARSSON, 2004; TORRENS; O'SULLIVAN, 2000). 

Models are composed by a number of elements, and the relations of them with 

its components have distinct levels of intensity and exchange of energy/information. 

The task of modeling this kind of system may use mathematical formalism, and one or 

more theories, based on a definition of the real aspect which is being captured 

(ROCHA, 2012). Computer models processes manipulate information and can 

generate a set of outputs to reflect the logic behind the model development (BATTY; 
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STEADMAN; XIE, 2006). Every model about a phenomenon aims to answer questions, 

as “How this process evolves?”, “Where the phenomenons are?” and “What is behind 

this phenomenon, which variables influence it?” (LAMBIN, 1994). 

Cellular automata models are a common choice in urban simulation, 

representing the development of a city in time and space, allowing the study of “what 

if” scenarios. Their application includes studies of traffic, urbanization and land 

development (TORRENS; O'SULLIVAN, 2000). They are usually chosen for this 

subject given the simplicity of modeling, the dynamic processes focus and the factors 

around those processes (LIU, 2008; BASTOS, 2007). Cells are natural representations 

for city blocks or individual buildings, and have dependency on the neighborhood. Also, 

CA can reflect self-organization properties (KRAFTA, 1999). 

The standard CA needs some modifications in order to fit the simulation of an 

urban system. This includes additional functionalities, usually used to explore the 

spatial complexity, test theories and ideas. These changes require strong calibration 

techniques to establish the model (TORRENS; O'SULLIVAN, 2000).  

CA are highly adaptable, may be compatible with geospatial data sets and can 

be integrate with Geographical Information Systems (GIS), as they are inherently 

spatial (WHITE; ENGELEN, 2000). GIS data can be used as initial parameters for a 

CA model, and simulation results can be fed back into GIS to be analyzed (CLARKE; 

GAYDOS, 1998). CA models complement GIS systems thanks to the ability to handle 

non deterministic aspects and to perform interactive cycles of simulation 

(TENODÓRIO et al., 2006). 

In order to employ CA in urban studies, the cell contents must be defined, as 

well as their possible states and the neighborhoods. Also, to define the transition rules 

and the randomness level, it is important to have knowledge of city history (BATTY, 

1997). As hypothetical examples of transition rules can be cited (LIU, 2008; COSTA, 

2010): 

 Rule 1 - development of a residential area:  

if three or more cells are developed then a not urban cell became urban 

 Rule 2 - influence of roads: 

a main road in an area increases the probability of development. 

CA has also limitations. They can be affected by the data errors, as positional 

imprecisions, mistaken attributes and unstable conditions. Errors in the model structure 

or logic will be propagated through the simulation process. These issues should remind 
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that simulations are just approximations and results may not coincide with the real 

world (LIU, 2008). 

 

4.1 PREVIOUS WORK 

Cellular automata in Urban Modeling started to be used around the 1950s. At 

this time, the CA research was in the beginning, and the urban researchers were 

building models to analyze the spatial patterns in the systems (BATTY; COUCLELIS; 

EICHEN, 1997). 

The first known applications of CA in urban and social studies became known 

around the 1960s, although some concepts appeared still earlier. Torsten Hagerstrand 

studied an innovation-diffusion model using the neighborhood notion 

(HAGERSTRAND et al., 1968). Lathrop and Hamburg (1965) developed a model 

based on cells to simulate the New York State. Chapin and his colleagues from 

University of North Carolina worked around the notion of flow linked to residential 

development (CHAPIN; WEISS 1968). One of these examples can be seen in Figure 

10, which represents Chapin and Weiss work, showing a flat residential area 

development, indicating the distribution sequence of new houses by a randomized 

process. 

 
Figure 10 - Sequence of distribution of residential households 

 

Source: Adapted from Chapin and Weiss (1968). 

Possibly the first official CA model was proposed by Waldo Tobler in 1979, for 

the simulation of urban grow in the city of Detroit. Among the first models, one that 

caught attention was the work from Couclelis, 1985, who tried a different approach and 

developed a model based on the "Game of Life". Despite this, his simulation was not 
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considered realistic, just a metaphor of urban growth (LIU, 2008; SANTÉ et al., 2010; 

COSTA, 2010). 

Around the 1990s a new perspective of models started to appear, when White 

and Engelen developed a CA model to simulate land use change dynamics (WHITE; 

ENGELEN 1993; LIU, 2008). Some of these “new era” models are listed in Chart 2. 

 
Chart 2 - CA urban models 

Model Authors Description 

White and 
Engelen 

White and 
Engelen 

Published in 1993, simulates the land use of a hypothetical city. 
Calculates the transformation transition potential of each cell, 
using it own state and it's neighborhood, and the transition 
probabilities in each interaction. Temporal scope between 15 and 
25 years (BASTOS, 2007). 

SimLand Wu 

Proposed in 1996, combines CA with multi criteria evaluation and 
analytic hierarchy process on the GIS environment. The cells 
states can be urban and not-urban, and vary between urbanized, 
industrial districts a road system. Works with three transition rules, 
the growth rate and degree of attractiveness are defined by the 
user (BASTOS, 2007). 

CLUE-S 
Veldkamp and 
Fresco; 
Verburg et al. 

The conversion of land use and its effects uses the combination of 
empirical analyses and dynamic simulation of 
competition/interactions between spatial and temporal dynamics of 
the system to simulate land-use changes (VERBURG et al., 1999; 
VELDKAMP; FRESCO, 1996) 

UGM model Clarke 

An urban growth model developed in 1997. Uses four variables to 
define the probability of one not-urban cell became urban. These 
variables are: actual state of the cell, soil slope, proximity of the 
roads and inclusion or exclusion of the simulation. Also have four 
kinds of urban growth: organic expansion, diffusion, 
spontaneous/self generation, and road system influenced. 
Temporal scope of 100 years (BASTOS, 2007). 

SLEUTH 
Clarke and 
Gaydos 

Proposed in 1998, the model was built to simulate the Bay Area, 
and started the project Gigalopolis. This model is used to the 
development of this work and will be better described in the follow 
section (COSTA, 2010). 

FCUGM 
Al-Ahmadi et. 
al 

The Fuzzy Cellular Urban Growth Model was developed by Al-
Ahmadi et. al, and published in 2008. The model involves fuzzy 
logic and fuzzy set theory to capture the transition rules 
probabilities (AL-AHMADI et al., 2009). 

 

 

TerraME 
Federal 
University of 
Ouro Preto; 

It is a multiparadigm modeling toolkit where the user can choose 
the different parts of the model (behavior, time, and space). Also, 
enables the combination of agent based, CA, SD and discrete 
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National 
Institute for 
Space 
Research 

event simulation paradigms.  Was developed by the Federal 
University of Ouro Preto and the National Institute for Space 
Research, both from Brazil (CARNEIRO et al, 2013). 

Source: Own Authorship. 

Besides the examples of Chart 2, there are also studies that make use of 

generic tools as Matlab (TAYYEBI; PIJANOWSKI; TAYYEBI, 2011; GUAN; WANG; 

CLARKE, 2005) or Netlogo (LAGARIAS, 2012). 

The Remote Sensing Center of the Federal University of Minas Gerais also 

developed simulation software called DINAMICA. It implements features that support 

CA models for geographical simulation, being freeware, but closed source. It is 

important to point out that in addition to these, there are several others tools and 

models used for urban simulation. 

Among the tools available, SLEUTH seems to be the most widely used in the 

field, and it is free and open source. This model is adapted to different scenarios by 

adjusting the spatial accuracy and the scale sensitivity (SANGAWONGSE; SUN; TSAI, 

2005). It can generalize and mirror the characteristics and the individuality of the 

region, and reveal new emergent particularities (SILVA; CLARKE, 2005). Besides 

modeling urban growth, it has also been employed to analyze how urban areas 

dominate land and produce natural impacts (United States Environmental Protection 

Agency, 2000 apud SANGAWONGSE; SUN; TSAI, 2005).  

 

4.2 SLEUTH MODEL 

SLEUTH probably is the most popular CA model to simulate urban growth. 

Developed using C language around 1997/1998 by Clarke, was created to predict land 

use in the San Francisco Bay Area. In this project it was used the Linux version, 

released in 2005. Its name is an acronym of the input layers used in the model: Slope, 

Land Use, Excluded Areas, Urbanization, Transportation and Hillshade. Runs in UNIX 

or UNIX-Based operating systems, includes the urban growth model (UGM) and the 

deltatron land use model (DLM) (RAFIEE et. al, 2009; DOUKARI et al., 2016). An 

example of the SLEUTH model can be seen in Figure 11, which shows the work 

developed by Silva and Clarke (2005) simulating the land use in the city of Porto, 

Portugal. 
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Figure 11 - Urban Evolution of the Metropolitan Area of Porto - Portugal 

 

Source: Silva and Clarke (2005). 

 The SLEUTH model incorporates the main characteristics of the CA model: a 

grid space of homogeneous cells, a neighborhood of eight cells, two possible cell 

states (urban/non-urban), and transition rules that work in sequential time steps. As it 

is a model developed for urban growth, some specific features were added to it 

(CLARKE; HOPPEN; GAYDOS, 1997; SILVA; CLARKE, 2005): 

 weight for cells: is possible to define how much a cell has influence on the 

urban growth by the color applied to that. The most influence has a cell, 

higher should be your value translated in color. As an example, in the roads 

layer from this project, the highways should be colored with white, and the 

neighborhood streets, with less influence, should be closer to black; 

 self-modification mechanism: allows rules to change when some behaviors 

are detected by perceiving the environment, this includes the location, 

neighborhood, land type and probabilities. The metrics are regulated by the 

self modification parameters; this happens when a growth boost happens 

or when the city growth declines significantly. 

SLEUTH has an automated calibration procedure, where the model 

parameters and constants are estimated and adjusted seeking refined results. The 

model can adapt to the main characteristics of the system using the history of the city 

as a basis to calculate them, what make possible the transitions between intense rapid 

growth to little or no growth. These are the characteristics make possible the creation 

of a simplified copy from the urban behavior (SILVA; CLARKE, 2005). 
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The tool requires the input of four different layers (Figure 11) (CLARKE; 

HOPPEN; GAYDOS, 1997): 

 Seed Layer: is the initial distribution from the urban areas, represented by 

the gray cells in Figure 12 - Seed layer. This data can be hypothetical or 

historical. To execute the model, is necessary to have at least four time 

cycles available for statistical calibration;  

 Slope Layer: used to regulate the weight of the slope-resistance. The layer 

is the result of the interpolation of a digital elevation model converted to a 

slope for every cell. In Figure 12 - Slope layer, the different colors represent 

different percentages of slope; 

 Excluded Areas Layer: identifies the cells that are not part of the growth 

process, including hydrographic regions, oceans and protected areas, it is 

represented by the black cells in the Figure 12 - Excluded areas layer; 

 Roads Layer: describe the roads at certain periods of time, represented by 

the red line in Figure 12 - Road layer; and uses a binary array to work. It 

has a buffer defined by the road gravity, control factor and defining the road 

attractiveness for development. 

 
Figure 12 - Input data layers used by SLEUTH model 

 

Source: adapted from Clarke; Hoppen; Gaydos (1997). 

SLEUTH execution follows five steps: model compilation, data input 

preparation, calibration, prediction and result output (YANG; LO, 2003). It starts 

reading the input layers, and initializing random numbers. An exterior loop analyzes 

the location growth ‘history’, to retain all the necessary data to perform the calibration 

phase. An interior loop compiles the CA and the growth rules for one cycle. Finally, the 

descriptive data is saved into a file used in the next calibration phases (CLARKE; 

HOPPEN; GAYDOS, 1997). 
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The model is controlled by five factors (CLARKE; HOPPEN; GAYDOS, 1997; 

SILVA; CLARKE, 2005): 

 Diffusion: define how the cells will be distributed and how the new 

settlements are going to move through the road system; 

 Breed: determines how the new settlements begin their own growth cycle; 

 Spread: decide how is going to happen the ‘organic growth’ expansion 

outside and the system will be filled inside; 

 Slope: influences the probabilities of steeper slopes have settlements; 

 Road Gravity: simulate the attraction of settlements to the road system. 

For SLEUTH the city is like a living organism, the model tries to replicate the 

transitions in the maps, and mimic the historical data, by computing its parameters 

(CHAUDHURE, CLARKE, 2013). Accordingly to Doukari et al., the spread factor is the 

coefficient with more influence in the model response variability. Using these factors, 

four different types of growth are allowed, they are defined as the growth rules, 

illustrated in Figure 13 and explained bellow (CLARKE; HOPPEN; GAYDOS, 1997): 

 spontaneous new growth: a location is randomly chosen and if it has one 

not urban cell that passes the slope test, it becomes a new urban location;  

 diffuse growth and spread of a new growth center: cells that passed in the 

diffusion test and the slope test, which means that they are reasonably flat, 

are urbanized; 

 organic growth: an area with three neighbors, that passes the spread slope 

test, becomes a new urban center; 

 road influenced growth: a random place, where is possible to find a road in 

given a distance, is moved to the road and spread to become a new growth.  

Figure 13 - SLEUTH Growth rules 

 

Source: Adapted from Clarke; Hoppen; Gaydos (1997). 
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As already been said, when the simulation detects intense growth or little/no 

growth the control parameters change. Intense grow, leads to the Diffusion, Spread 

and Breed factors to increase, what encouraged the tendency of an expanding system. 

When the contrary happens, this factors change to what look like to a depressed area 

(SILVA; CLARKE, 2005). 

The calibration is performed using Monte Carlo simulation to record the history 

of the urban growth and is based in the phases: coarse, fine and final. First, hierarchical 

spatial resolutions are used to adjust the parameters that are related to the growth, 

and then a finer resolution is used to adjust the distinct parameters. After finding the 

range for the historical data, the calibration is repeated two times, what results in a 

narrower range of parameters (DIETZEL; CLARKE, 2007). Basically, the model 

calibration should be executed three different times, using different image sizes. The 

coarse phase should use images with ¼ of the full size, and the coefficients must 

include all the available range (0 - 100). The second phase, called fine, should have 

images with the half of the size of the full size images and the coefficients must be 

defined using the range with better results achieve in the first calibration phase. In the 

final phase, the range used is even more refined, as it is a result from the fine step, 

and the full resolution images are used. 

In each phase, the results of the metrics are ordered, and the ones that 

synthesize the system behavior, are extract to the next phase. The four maps with 

different information, 13 metrics, and the interaction between then, create a set of 

thousands of different combinations for each cell. The combinations that reflect the 

growth rules are tested in a simplified space, resulting in refined values, which will be 

tested again in a more detailed space, successively. Thus the characteristics are 

adjusted saving processing time. The variations between phases verify the behavior of 

the elements, their performance in different scales, their development, their variations 

and their importance on the system (COSTA, 2010). These phase improves the 

simulation and the data used, giving the possibility to run a simulation closer to the real 

world (SILVA; CLARKE, 2005). 

As any simulation model SLEUTH has some limitations that worthy be discussed. 

The model is very time consuming, and has a calibration process sensitive and 

subjective. It has difficulties to simulate growth that is not originated organically, and 

sometimes the randomness and cumulative probability may affect the model 

performance (WU et al., 2009).   
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5 DEVELOPMENT 

Figure 14 represents workflow of this project. It began with a review of literature 

related to urban phenomena and the cellular automata models. Following the 

bibliographic research, a practical study of SLEUTH took place. The tool was installed 

and tests were executed in order to understand the various parameters and data 

sources involved. 

 
Figure 14 - Project workflow 

 
Source: Own Authorship 

When the tests started, crashes were observed. The flaw, a string overflow, 

was found in ‘landclass_obj.c’: 

 

    char zeroes[] = "000000"; 

    char hex_str[6]; 

    strcpy (hex_str, zeroes); 

    strcpy (hex_str + 6 - strlen (color_str), color_str); 

 

The first successful test with SLEUTH was in May/2018. The calibration 

process took 45 hours, divided into 3 hours for coarse calibration, 16 hours for fine and 

26 hours used in the final phase. 
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5.1 STUDY AREA 

Ponta Grossa is a Brazilian city, located in the south state of Paraná. Its origins 

go back to 1700, when the region was traversed by cattle merchants. The city was 

recognized as such in 1862. It has been the destiny of many immigrants, and today it 

is mainly known as a convergence point of many roads (Prefeitura Municipal de Ponta 

Grossa, 2018). 

It has an average altitude of 975 meters, and a total is of 2054,735 km². 

Accordingly the census population estimate of 2014, the city had 334535 inhabitants.  

These years was used in the calibration process, to compare the SLEUTH forecasting 

for 2017 with the real data available. The city borders with Palmeira, Teixeira Soares, 

Campo Largo, Tibagi and Ipiranga. Has an extensive hydrographic network and the 

economy is based on several activities, as industries, agriculture and tourism. 

 

5.2 DATA PREPARATION 

SLEUTH depends on a set of input files, corresponding to the layers that form 

the SLEUTH acronym: topographic Slope, zones Excluded from growth, Urban spatial 

extent, Transportation networks, terrain Hill shading, and categories of Land Use; this 

last one is not mandatory and was not considered in this project. All these layers are 

represented as gif images. The tool requires a minimum of four images of urban areas 

in different periods and two maps of roads in different dates. It outputs several log files, 

the two most important being represented in Figure 15. 

 
Figure 15 - SLEUTH inputs and outputs 

 

Source: Own Authorship 
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The files used in the study have 1242x1339 pixels, with a spatial resolution of 

30 meters per pixel. The non-urbanized areas of the city were removed. The city hall 

does not keep city historical data, so in order to prepare layers for SLEUTH, information 

from IPLAN (Instituto de Pesquisa e Planejamento Urbano de Ponta Grossa), Google 

Earth, and INPE (Instituto Nacional de Pesquisas Espaciais) were collected. This 

includes GIS digital data sources, satellite images, and topographic maps.  

A road layer for 2017 was built with the help of the software Quantum GIS 

(QGIS), extracting data from the OpenStreetView project with a plug-in called Open 

Layers. Several images were obtained this way, but there were differences between 

them with respect to the roads. A few important streets were not present and had to 

be added manually in the images. In order to delimit the city borders and extract just 

the information of interest it was used a shape file from the IBGE (Instituto Brasileiro 

de Geografia e Estatística) database, which contains the Brazilian cities administrative 

borders.  

Due to the lack of historical files for roads, layers for previous years were 

constructed by hand. The manual procedure consisted of erasing from the current map 

the streets which did not exist on 1984 and 1996, according to satellite images. In all 

road layers, isolated streets, without connection to other roads, were deleted. 

Roads layers in SLEUTH employ shades of grey for classification. In this 

project, roads connecting to other cities were painted with the highest value (100); 

avenues and streets that connect the neighborhoods to these roads and have a 

substantial impact were marked with the intermediate value (50). Other streets have 

the lowest value considered (25). These values are indicated in the documentation. 

The resulting image can be seen in Figure 16. 
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Figure 16 - Roads Layer 

 

Source: adapted from OpenStreetView 

To create the layers Slope and Hillshade, four tiff images were downloaded 

from the Aster Global Dem (ASTER GDEM) dataset in Earth Explorer site. ASTER 

GDEM is a product of METI and NASA and contains the Digital Elevation data collected 

by the Aster instrument on the Terra satellite.  

The images were opened on the QGIS software and Hillshade and Slope data 

were extracted using the Analysis of DEM option. It is worth mentioning that, as 

SLEUTH uses the color on the Slope image to identify the degree of inclination, the 

image was extracted using the percentage option instead of the degree expression. 

The slope and hillshade images can be seen in Figure 17. 
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Figure 17 - (a). Slope Layer; (b). Hillshade 

 

(a) 

 

 

(b) 

Source: adapted from Earth Explorer/ASTER GDEM 

 

The excluded area layer represents regions where growth is not possible or 

not allowed. It was based on the Municipal Director Plan developed in 2001 by the 

Ponta Grossa IPLAN (Institute for Research and Urban Planning). From this document, 

it was used the Conservation Unit section and the image available in the official site 

from the Institute. The regions represented in this layer correspond to the Campos 

Gerais National Park, Vila Velha State Park, Environmental Protection Area of the 

Devonian Escarpment and Tibagi River Wildlife Refuge. Cities surrounding Ponta 

Grossa were also added in this layer. The result is shown in Figure 18. 

 
Figure 18 - Excluded Areas (White: excluded - black: not excluded) 

 

Source: adapted from Municipal Director Plan - 2001 
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Urban layers representing the city footprint were developed manually, using 

data downloaded from Google Earth, which uses Landsat and CNES/Airbus data, and 

aerial pictures from INPE (Instituto Nacional de Pesquisas Espaciais). Urban areas 

were identified visually and colored manually (Figure 19).  

 
Figure 19 - Urban Area identification 

Before identification 

 

After identification 

 
Source: adapted from Google Earth 

The urban layers were separated by a difference of three years. The available 

images were overlapped to compare urban spots and help the identification of urban 

and not urban areas. Some zones were difficult to classify; one example of this issue 

can be seen in Figure 20. 

 
Figure 20 - Undecidable / unrecognized area 

 
Source: adapted from Google Earth 
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Next, the images were overlapped to check the urban borders. This was 

necessary because the images had different levels of quality. One of the layers 

resulting from this approach can be seen in Figure 21, corresponding to 1984. 

 
Figure 21 - Urban layer, 1984 (White: urban - Black: not urban) 

 

Source: Own Authorship 

 

5.3 CITY REGIONALIZATION 

In the next phase of the project, simulation was performed with separated city 

regions, and different images for exclusion layers had to be prepared. Different 

approaches were initially considered for the city regionalization, as using a simple 

square division, or by area size. The chosen regionalization was based on a few 

criteria, related to the position of highways and important streets, social aspects and 

the neighborhood shape (Figure 22). Brazilian cities adopt a ‘neighborhood division’ 

(bairros), useful for postal code definition and localization. It is quite usual that such 

‘bairros’ show distinct socioeconomic differences. In order to localize neighborhoods, 

a shape file was downloaded from IPLAN, corresponding to the city neighborhoods in 

2008. 
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Figure 22 - Regionalization of the city 

 

Source: Own Authorship 

The map was divided into three large areas that have a certain level of 

independence: all three areas in Figure 22 have pharmacies, markets, banks, and 

stores. The city center is inside all the subdivisions and, far neighborhoods of Oficinas 

and Periquitos make part of two regions each one.  

A small overlap was set between neighbor regions, to permit interactions 

between them as diffusion and organic growth in SLEUTH. The overlap can be seen 

in Figure 23, represented by brownish and purplish colors. 

 
Figure 23 - Overlap between subdivisions 

 

Source: Own Authorship 

Two different approaches were used for calibration and simulation. In the first 

one, only the excluded areas were modified. The exclusion layer of each experiment 
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contained just the region available for growth. The resulting images can be seen in 

Figure 24. 

 
Figure 24 - Excluded layers of each subdivision 

Subdivision 1 Subdivision 2 Subdivision 3 

   

Source: Own Authorship 

In the second approach, the urban layers were modified, and regions were 

painted with black to remove parts of the city. The reason for doing this was to observe 

the behavior of SLEUTH with regard to calibration. In the Figure 25 below is possible 

to see the layers used for the year of 1984 in each subdivision. 

 

Figure 25 - 1984 urban layers for each subdivision 

Subdivision 1 Subdivision 2 Subdivision 3 

   

Source: Own Authorship 

There were a total of eighteen .gif files for the first round of calibrations, and 

fifty six for the second. They are: 

 One slope layer; 

 One hillshade; 

 Three roadmaps;  

 Four excluded area maps; 

 Forty eight urban spots. 
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5.4 CALIBRATION AND PREDICTION PROCESS  

The experiments were performed using two different time intervals: from 1984 

till 2014, and from 1984 till 2017. The first time interval (1984 - 2014) chosen as it 

allows the comparison between SLEUTH forecasting results with the real data 

available (2017) and the second to observe how the model predicts the near future 

(2020).  

In addition to the use of two time intervals, the simulation was executed using 

the three different setups for exclusion layer explained in the previous section, for a 

total of six sets of results. Each of these six sets involved four rounds of calibration 

(Figure 26), following the procedure recommended in SLEUTH documentation, totaling 

14 different simulations. 

 
Figure 26 - Calibration process 

 
Source: Own Authorship 

The coarse calibration is the first phase of the SLEUTH calibration process. 

During calibration, the tool performs several simulations while the values of the five 

parameters (spread, diffusion, slope, and road) are varied within a prescribed range. 

For the coarse process, the images had only one quarter of the full size, or 310x334 

pixels. The parameters were varied from 0 to 100 in steps of 25 units. Each 
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combination of parameters was used in five runs of Monte Carlo simulation. These 

parameters are recommended in SLEUTH documentation. This calibration step took 

approximately 36 minutes in a computer with 6 GB of RAM, core i3 processor and a 

CPU of 2.20 GHz.  

For the fine calibration, the scenario file was configured to run eight Monte 

Carlo simulations, with input files that had half the full size images, or 621x670 pixels. 

The SLEUTH logs derived from the previous phase are used to define the scenario 

coefficients. The control_stats.log file contains the results of all simulation runs: 5 

Monte Carlo simulations to calculate the output for each combination, for a total of 55 

= 3125 results.  

The parameters are chosen according to the metrics computed by SLEUTH. 

Using a spreadsheet editor, the control_stats.log was organized and the results sorted 

in decreasing order using the chosen metric. 

In the present study it was used the Lee Salle metric. The range selected for 

the parameters was based on the top 10 results. In this phase, the difference between 

the start and stop values was at least 25. The step was defined by the result of the 

subtraction of the start and stop values divided by 5. In this phase, the calibration took 

near to 7 hours to finish. 

In the final phase, the preceding steps were executed once again. There was 

more than 6000 simulation runs, depending on the scenario, and only the top six results 

were considered. For the final calibration, the difference between step and stop was 

minimum 5. The number of Monte Carlo simulations was raised to ten and the images 

used had 1242x1339 pixels. This calibration phase took approximately 38 hours to 

complete. 

A fourth calibration is performed in order to execute the Prediction for the city. 

It is known in SLEUTH documentation as ‘forecasting calibration’; this step derives the 

Prediction coefficients, also known as Best Fit. To execute the forecasting, the number 

of Monte Carlo simulations was raised to 150 and the full size images were used. The 

coefficients were defined using the result with the highest Lee Saale metric in the 

control_stats.log derived from the Final calibration. In this scenario, the start and stop 

values were the same, and the step was set to one, meaning that a single set of 

coefficients would be considered.  

For the Prediction step, the number of working grids was raised to six. The 

number of Monte Carlo simulations was the same used in the Forecasting calibration 
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(150) and the full size images were used again. The coefficients for this run were 

defined by the file avg.log, derived from the forecasting calibration. The values of 

coefficients corresponding to the Stop Date, last year available, are selected, rounded 

and informed in the scenario as the Best Fit values. Also, the prediction dates, were 

defined: the start was 2014 or 2017 (two data ranges were used) and the stop date 

was set as 2017 or 2020, respectively.  

The coefficients used in the calibrations and in the Prediction, can be 

visualized in Table 1; the results will be detailed in the next section. As a way to simplify 

the reading , the simulations will be identified as follow: C, for the simulation using the 

whole map; E, when only the Excluded Layer was modified to represent each region 

of the city; and, S, when the city map was also modified to select only a subdivision for 

analysis. 
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Table 1 - Coefficients used in the simulations 

 
Comp - 
2014 

Comp -
2017 

Excl 1 - 
2014 

Excl 1 -
2017 

Sub 1 - 
2014 

Sub 1 -
2017 

Excl 2 - 
2014 

Excl 2 -
2017 

Sub 2 - 
2014 

Sub 2 -
2017 

Excl 3 - 
2014 

Excl 3 -
2017 

Sub 3 - 
2014 

Sub 3 -
2017 

  Fine Fine Fine Fine Fine Fine Fine Fine Fine Fine Fine Fine Fine Fine 

Diffusion 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 

Breed 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-25 0-50 0-25 0-25 

Spread 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 75-100 

Slope 0-25 0-25 0-25 0-25 0-25 0-25 50-100 0-50 0-100 0-100 0-25 25-50 50-75 25-50 

RG 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 0-100 

  Final Final Final Final Final Final Final Final Final Final Final Final Final Final 

Diffusion 0-5 0-5 0-5 0-5 0-5 0-5 0-10 0-10 0-5 0-5 15-20 0-5 0-10 0-25 

Breed 5-20 0-25 20-25 20-25 5-15 5-25 0-15 20-25 0-5 5-10 15-20 30-35 10-20 10-15 

Spread 95-100 95-100 95-100 95-100 95-100 95-100 95-100 95-100 95-100 90-100 95-100 95-100 95-100 95-100 

Slope 20-25 20-25 0-5 0-5 5-10 0-10 50-55 0-5 20-25 20-25 0-5 25-30 50-55 25-30 

RG 25-100 0-50 0-100 0-100 0-100 0-75 0-75 0-100 0-100 0-100 0-75 0-100 0-50 0-100 

  Fore Fore Fore Fore Fore Fore Fore Fore Fore Fore Fore Fore Fore Fore 

Diffusion 2 5 1 1 4 5 1 4 1 5 15 1 1 1 

Breed 14 25 23 24 7 25 12 24 4 5 17 31 20 13 

Spread 100 100 100 98 100 99 100 99 100 100 95 100 100 100 

Slope 20 20 1 1 5 1 50 1 20 20 1 25 50 25 

RG 40 40 25 25 50 15 1 75 50 1 1 1 1 1 

  Predict Predict Predict Predict Predict Predict Predict Predict Predict Predict Predict Predict Predict Predict 

Diffusion 0 0 0 0 0 0 0 0 0 0 1 0 0 0 

Breed 1 1 1 1 0 1 1 1 0 0 1 1 1 0 

Spread 5 3 5 3 5 4 5 3 6 5 4 3 5 3 

Slope 100 100 100 100 100 100 100 100 100 100 100 100 100 100 

RG 27 26 0 0 27 0 1 1 1 1 1 1 1 1 
Source: Own Authorship
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6 EXPERIMENTS RESULTS 

By observing the parameters obtained in the calibration processes, it was 

possible to get a general picture of how the SLEUTH model tries to assimilate the city 

of Ponta Grossa. The following sections analyze the results that were computed from 

the phases of calibration, forecasting, and prediction. 

 

6.1  FINAL CALIBRATION PHASE 

6.1.1 Complete Map  

The coefficients from the Final phase of the calibration process from 2014 and 

2017, for the complete city map, are represented in Graphic 1. The Diffusion and Breed 

coefficients suggest that the emergence of new urban centers far away from the major 

urban spot was rare; when that happened, they usually grew slowly, as the values are 

below 25.  

 
Graphic 1 - Complete Simulation - Final calibration results for 2014 and 2017 

 
Source: Own Authorship 

The high value for the Spread coefficient corresponds to a high percentage of 

organic growth during the analyzed periods. This coefficient was the most significant 

in the simulation, meaning that the organic sprawl was the major process responsible 

for city expansion. Figure 27, shows the actual city maps for the years 1984, 1993, 

2002 and 2014. Observing the maps it is possible to conclude that the city seems to 
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grow mainly by spreading the existing urban mass, as the organic growth description, 

agreeing with what was detected by SLEUTH. 

 
Figure 27 - Urban spots from the years (a) 1984, (b) 1993, (c) 2005 and (d) 2014, 
representing the urban spread 

(a) 

 

(b) 

 

(c) 

 

(d) 

 

Source: Own Authorship 

The Slope resistance coefficient has low values, near to 30. While doing the 

simulations, it seemed that the Road Gravity coefficient did not have a great influence 

either. In the final phase results, this coefficient stabilized with a medium rate in 2014 

simulation best results. But, it fluctuated in the best results achieved in the 2017 

simulation, showing that the difference between its results have low impact in the Lee 

Salee metric. 
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6.1.2 Subarea 1 

The majority of the results for simulations corresponding to S1 presented the 

highest rate of organic growth (spread). This can be visualized in Graphics 2 and 3, 

and means that the city growth happens around areas that are already urbanized. 

Besides this, the results computed by SLEUTH show that, in this region, new city 

centers are rare or not existent. Only a few spots appear around the city over the years. 

 
Graphic 2 - Final calibration best results for 
Subarea 1/2014 approaches 

 
Source: Own Authorship 

 
Graphic 3 - Final calibration best results for 
Subarea 1/2017 approaches 

 
Source: Own Authorship 

The low value of Breed coefficient means that the probability of growth in such 

areas was low; however, a small change between simulations was detected by the 

model, and the Breed coefficient rise to 25. This may be the result of the appearance 

of new spots between 2014 and 2017, what can be visualized in Figure 28. 

 
Figure 28 - Comparison of the same area in 2014 (a) and 2017 (b), showing new urban spots 

(a) 

 

(b) 

 

Source: Own Authorship 
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In the simulations of the first subdivision, the most significant differences 

occurred in Slope Resistance and Road Gravity. It seems that in the first area 

analyzed, the slope is less significant than in the rest of the city, meaning that this 

aspect has little effect on the urbanization. This characteristic can be observed when 

the slope and urban spot maps are compared. Figure 29, shows the urban spot over 

the slope map and the slope of this area. The areas with high slope are the lighter ones 

in the image, and, as can be perceived, some of these regions are urbanized.  

 
Figure 29 - Subarea 1 urban spot superimposed over the slope map (a) and the slope of the 
urban area (b) 

(a) 

 

(b) 

 

Source: adapted from Earth Explorer 

The Road Gravity coefficient seems to have a medium impact in urban growth 

in 2014, with values for the final calibration higher than 25. But in the 2017 simulation 

the value of this coefficient floated between 1 and 75. 

Both Slope and RG coefficients were very different between the exclusion and 

the subdivision approaches. This may have happened because when the model is 

calibrated, the excluded areas are ignored by the process, but they are considered in 

the calculation of the Lee Salee metric. This metric compares the simulated pixels with 

the real ones. It is computed by dividing the intersection area by the union of the urban 

areas, as seen in the code of stats_obj.c: 
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static void stats_compute_leesalee (GRID_P Z, GRID_P urban, double 

leesalee){ 

{…} 

  for (i = 0; i < mem_GetTotalPixels (); i++){ 

    if ((Z[i] != 0) || (urban[i] != 0)){ 

      the_union++; 

    } if ((Z[i] != 0) && (urban[i] != 0)) { 

      intersection++; 

    } } 

  *leesalee = (double) intersection / the_union; 

  {…} 

} 

 

6.1.3 Subarea 2 

As it happened with the simulations for S1, in S2 the coefficients controlling 

the occurrence of new random urban centers were low. This is shown in Graphics 4 

and 5. The values for spread also repeated what happened with the subarea 1, with 

high values for organic growth.  

 
Graphic 4 - Final calibration best results for 
Subarea 2/2014 approaches 

 
Source: Own Authorship 

 
Graphic 5 - Final calibration best results for 
Subarea 2/2017 approaches 

 

Source: Own Authorship 

The bigger differences are seen in the Slope and RG coefficients. In the 

second subdivision, land declivity has a higher impact in the city growth than in the S1, 

showing slightly more influence on the way that this area spreads. Road Gravity also 

seems to have more importance on how urban spots sprawl. In the last phase of 

calibration, the values for the top results of the RG were above 50, showing moderate 
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relevance. This characteristic detected by SLEUTH matches what is observed in the 

maps. Figure 30 shows that this area developed mostly around city highways. 

 
Figure 30 - Urban spot overlapped by the roads 

 

Source: Own Authorship 

In the 2017 calibration, the RG coefficient varied between 1 and 100 in the top 

results. This may indicate that SLEUTH could not narrow the range of this parameter 

as a function of the growth. Likewise, in the subdivision 1, the excluded area simulation 

had results very different from the subdivision approach, mainly in the coefficients 

Slope and RG. In 2014 calibration the Slope was 50 in E and 20 in S, and in 2017 it 

was 1 in E and 20 for S. The RG results also had mixed patterns, in 2014 the E top 

result was 1 and S 50, in 2017 E was 75 and S 1. 

  

6.1.4 Subarea 3 

This subdivision repeated previous with high percentage of organic growth and 

little chance of creation of new urban centers randomly. The values are shown in 

Graphics 6 and 7. The probability of these new urban centers develop slightly change 

between 2014 and 2017, but this value does not exceed 35 in any of the experiments.  
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Graphic 6 - Final calibration best results for 
Subarea 3/2014 approaches 

 
Source: Own Authorship 

Graphic 7 - Final calibration best results for 
Subarea 3/2017 approaches 

 
 Source: Own Authorship 

In the subdivision simulation there are significative differences in the Slope 

coefficient, for the approaches used for 2014. Slope resistance had moderate 

importance in this area, higher than in the simulation of the whole map and in the 

exclusion area approach. But the value of this coefficient decreases for 2017, which 

may represent that the new areas in the subdivision are not influenced by the slope. 

The RG coefficient also showed large variations in the best results of the Final 

calibration, both in 2014 and 2017 experiments. 

 

6.2 METRICS  

6.2.1 Lee Salee 

The definition of the top results in each calibration phase and selection of 

coefficients for the next step was based on the LeeSaale metric. It measures the spatial 

adjustment between the simulated city and the actual maps (OGUZ, 2004); the 

resulting values are between 0 and 1, which represents the perfect fit. Values of this 

metric are shown in Graphics 8 and 9, from the 2014 and 2017 simulations. 
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Graphic 8 - LeeSalee metric of 2014  

 

Source: Own Authorship 

Graphic 9 - LeeSalee metric of 2017  

 
Source: Own Authorship 

Analyzing this metric for the best scores of each simulation, it can be seen that 

the subdivision simulations had best results for S1 and S3. S3 showed 69% (0,69) of 

spatial accuracy in 2014, the best result of all the simulations executed. The remaining 

simulations had similar results in the coarse and final steps, distancing just in the fine 

phase. 

The excluded areas approach had the lower results in both years. The 

probable cause is the fact that SLEUTH does not ignore excluded areas when it 

calculates statistics. This spatial accuracy for this type of simulation ranged between 

55% and 69%. 

 

6.2.2 Compare Metric 

The ‘compare metric’ from SLEUTH makes a comparison between the amount 

of simulated pixels and the real ones (OGUZ, 2004), the results can range from 0 to 1. 

Results are shown in Graphics 10 and 11.  
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Graphic 10 - Compare metric of 2014  

 
Source: Own Authorship 

Graphic 11 - Compare metric of 2017  

 
Source: Own Authorship 

The results for this metric were mostly inconclusive, and varied between 38% 

(0,38) and 58% (0,58). Among all, by averaging the results of each phase, in both, 

2014 and 2017, the best result was from S3.  

 

6.2.3 Pop Metric 

The ‘Pop metric’ employs Least Squares Regression to interpolate the number 

of urbanized pixels in the input maps (OGUZ, 2004), 0 is the lowest value and 1 the 

highest. The Graphics 12 and 13 illustrate this metric.  
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Graphic 12 - Pop metric of 2014  

 
Source: Own Authorship 

Graphic 13 - Pop metric of 2017  

 
Source: Own Authorship 

This metric, as in the previous one, showed mixed results. Almost all the 

results were not continuous or balanced. Between them, the best results were in 2014 

were in S3 and E2, and in 2017 in S2. 

 

6.3 FORECASTING AND PREDICTION RESULTS 

Forecasts were calculated for the year 2017 and 2020 using the results from 

the calibration process, having as inputs images from 1984 until 2014 for 2017 and 

from 1984 until 2017 for 2020.  

The values of forecasting parameters can be seen in Graphic 14. Of the five 

parameters, Spread showed unexpected low values, if compared to what was found in 

other experiments. 
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Graphic 14 - Coefficients derived from Forecasting  

 

Source: Own Authorship 

The same behavior happened in the rest of the simulations, as it can be seen 

in Graphics 15 and 16. After performing the Forecasting and Predict phases, it was 

possible to perceive that they were not in accordance with expectations. This because 

the resulting value for the Spread coefficient was very low, as well as the modeled 

pixels, and did not seem to agree with the behavior of the city, which is of continually 

growing. 

 

Graphic 15 - Forecasting results for 2017 in all approaches 

 

Source: Own Authorship 

Graphic 16 - Forecasting results for 2020 in all approaches 

 

Source: Own Authorship 
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6.3.1 Prediction for 2017 

In this experiment, SLEUTH generated a low number of pixels, in all 

simulations performed. This is shown in Table 2. Approximately 47 pixels were 

documented in the avg.log in the simulation for the complete city, a total of 51 for the 

excluded areas approach and 55 for the subdivisions.  

Beyond the modeled pixels documented in the logs, SLEUTH present in the 

resulting images pixels with different probabilities of creation. These pixels have 

different colors, which represent the probability of its appearance. A small tool was 

programmed to count pixels in the images. There were 842 for the complete simulation, 

909 for the excluded areas and 992 to the subdivisions, all them had a low chance to 

appear, between 0 and 20%. These results were far from the actual map; the difference 

is about 9000 pixels, as shown in Table 2. The value of the sums of the excluded and 

subdivision are higher than the complete approach because of the overlap between 

neighborhoods, which is described in section 5.3. 

 
Table 2 - Modeled Pixels vs. Real Pixels 

 Avg.log 0 - 20% -SLEUTH SLEUTH Total Real Pixels 

Complete 46,81 842 888,81 10223 

Excluded 1 15,24 272 287,24 5429 

Excluded 2 23,63 425 448,63 3554 

Excluded 3 12,36 212 224,36 4100 

Total  51,23 909 960,23 13083 

Subdivision 1 15,04 271 286,04 5428,01 

Subdivision 2 25,51 456 481,51 3554 

Subdivision 3 14,5 265 279,5 4100 

Total  55,05 992 1047,05 13083 

Source: Based on SLEUTH outputs 

 The difference of growth rates between the SLEUTH simulation and the real 

data can be visualized in Table 3. It shows that the city had a considerable expansion 

in three years, which was not detected by the model. 
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Table 3 - Growth Rate - SLEUTH vs. Real 

 SLEUTH Real 

Complete 0,618232396 6,995818791 

Excluded 1 0,196564622 3,714506105 

Excluded 2 0,307007459 2,432081024 

Excluded 3 0,153534524 2,805043454 

Subdivision 1 0,452251526 8,58210672 

Subdivision 2 0,790994513 5,838288925 

Subdivision 3 0,45510062 6,674282614 

Source: Own Authorship 

With a slight adaptation of the code that counted pixels, it was possible to verify 

the degree of coincidence between simulated and real pixels. The model also 

presented a low performance, as can be seen in Table 4, which shows that the hit rate 

was low, with a maximum of 35%. 

 
Table 4 - Hits and Misses from SLEUTH results 

 Misses Hits Total % hits 

Complete 559 283 842 33% 

Excluded 1 210 62 272 23% 

Excluded 2 276 149 425 35% 

Excluded 3 138 74 212 35% 

Total 624 285 909 31% 

Subdivision 1 218 53 271 19% 

Subdivision 2 326 130 456 28% 

Subdivision 3 182 83 265 31% 

Total 726 266 992 26% 

Source: Own Authorship 

Analyzing the avg.log derived from Forecasting phase, is possible to 

understand why the coefficients for the prediction were low. The Table 5 is derived 

from the avg log. It is possible to see that the model was not able to accompany the 

city development, showing a low number of urban pixels. The image for 2014 had 

approximately 146 thousand urban pixels, and SLEUTH calculated just around 63 

thousand. Between 1987 and 1990 the city grew more than 10 thousand pixels, but 

the simulation generated only 129. 
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Table 5 - Information from the avg.log 

year index area grw_pix real area 

1987 1 61188.87 379.23 68471 

1990 2 61983.88 219.56 79755 

1993 3 62439.62 125.05 90453 

... 

2008 8 63027.33 11.07 123329 

2011 9 63054.75 8.51 130485 

2014 10 63075.23 6.22 146130 

Source: Based in the complete approach simulation avg.log 

6.3.2 Model Predictions for 2020 

The prediction for 2020 repeated the behavior results of 2017. Table 6 shows 

the number of pixels generated in all the approaches used. For the complete map, 

SLEUTH modeled a total of 578 pixels for 2020. The excluded approach generated 

about 654 pixels in all approaches. The subdivision approach produced a total of 940 

pixels for 2020. The results are shown in Table 6.  

 
Table 6 - Pixels modeled by SLEUTH 

 Avg.log 0 - 20% Total 

Complete 30,04 548 578,04 

Excluded 1 11,86 195 206,86 

Excluded 2 14,28 252 266,28 

Excluded 3 9,96 171 180,96 

Total  36,1 618 654,1 

Subdivision 1 14,45 271 285,45 

Subdivision 2 23,21 447 470,21 

Subdivision 3 9,82 175 184,82 

Total  47,48 893 940,48 

Source: Own Authorship 

According to these results, Ponta Grossa would grow about 0.60% in the S 

approach, 0.41% in the E and 0.36% in the complete simulation. These values are 

different than expected, as the city grew between 16.5% and 2.4% in the intervals used 

in the simulation. This can be seen in Table 7. 

 



69 
 

Table 7 - Urban layers information 

Year Urban Pixels Urban % Growth Pixels Growth Rate % 

1984 59822 2,69 - - 

1987 68471 3,13 8649 14,46 

1990 79755 3,69 11284 16,48 

1993 90453 4,43 10698 13,41 

1996 100806 5,04 10353 11,45 

1999 107895 5,53 7089 7,03 

2002 112217 5,72 4322 4,01 

2005 120469 6,14 8252 7,35 

2008 123329 6,37 2860 2,37 

2011 130485 6,76 7156 5,80 

2014 146130 7,54 15645 11,99 

2017 156353 8,19 10223 7,00 

Source: Own Authorship 

SLEUTH results were lower than expected in these simulations. More 

experiments were performed to see how the model would behave for 2030 using the 

same parameters used for 2020. The values obtained in these tests can be seen in 

Table 8. 

 
Table 8 - Modeled pixels for 2030 

2030 Avg.log 0 - 30% Total 

Complete 94,25 1627 1721,25 

Excluded 1 37,42 622 659,42 

Excluded 2 46,23 763 809,23 

Excluded 3 30,66 521 551,66 

Total 114,31 1906 2020,31 

Subdivision 1 45,23 738 783,23 

Subdivision 2 67,35 958 1025,35 

Subdivision 3 30,56 526 556,56 

Total 143,14 2222 2365,14 

Source: Own Authorship 

The number of pixels generated in the simulation was again lower than 

expected, and the sum of them was near the growth accumulated in three years 

according to Table 7. According to SLEUTH, Ponta Grossa would grow 1.1% in the 

complete simulation, 1.29% in E and 1.51% in S. 
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6.4  PREDICTION FOR 2020 AND 2030 - DIFFERENT PARAMETERS 

As the results obtained using the SLEUTH calibration values were different 

than expected, new settings were used to run predictions for 2020 and 2030. For this 

new experiment, it was used the complete simulation approach (with no regionalization 

of the maps). To define the parameters, it was observed the behavior of the results in 

the calibrations, and to seek higher growth percentage. The diffusion and breed were 

increased to enable random growth, the Spread was based in the final calibration 

results, and the Slope and Road Gravity were defined to have greater influence than 

seen in the calibrations. The parameters were set as following: Diffusion was set to 30, 

Breed 50, Spread 100, Slope 40 and RG 30. Figures 31 and 32 show the result for 

2020 and 2030. 
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Figure 31 - 2020 prediction with zoom in one of the areas with probable growth 

 
Source: SLEUTH 
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Figure 32 - 2030 prediction with zoom in one of the areas with probable growth 

     
Source: SLEUTH 

The results of both predictions had better results than the previous ones, and 

the city growth for 2020 was near to the usual city growth observed in the city maps. 

In this experiment, was also possible to observe others sets of growth probabilities, 

which can be seen in Table 9. 
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Table 9 - Pixels modeled for 2020 and 2030 

Probabilities 2020 2030 

0 - 10 2684 3813 

10-20 1319 1425 

20-30 1011 975 

30-40 781 798 

40-50 542 797 

50-60 369 632 

60-70 227 612 

70-80 119 534 

80-90 29 461 

90-100 0 539 

avg.log 1745,29 3689,39 

Total 8826,29 14275,39 

Source: Own Authorship 

Using the parameters mentioned above, the results for 2020 were closer to the 

city usual growth. This result means that the calibration results for Ponta Grossa were 

inappropriate and the value for the Spread should be higher than the one achieved by 

SLEUTH. The results for 2030 were lower than expected, however they were better 

than the presented in the previous simulations. 

 

6.5  ANALYSIS 

Observing SLEUTH results it was possible to draw some conclusions about 

how the model responded to the data. SLEUTHs compute an average of the complete 

city behavior, what was expected, but if a region with complete different characteristics 

is part of the simulation some of them may be lost. When the subdivisions were 

simulated separately, SLEUTH results were slightly different for some coefficients, 

reveling different behaviors. One example is slope resistance, which, according to the 

results of the SLEUTH, has not the same importance across the city. There are also 

some differences in the Breed coefficient.  

The type of growth in turn, proved to be highly organic in all the subdivisions. 

This was represented by the high Spread values, with very small differences among 

the simulations. Diffusion also presented a regular pattern, with low values for the all 

sub regions. Although the values were low, it was possible to observe that SLEUTH 
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detected small changes in the Diffusion between 2014 and 2017, and this change of 

behavior can be observed in the maps used as input in the experiments.  

Road Gravity results were irregular. The coefficient showed great variations in 

several simulations, and did not seem to have a big impact in the metric Lee Salle. In 

the simulations performed, this coefficient was significant only in a few cases. The relief 

of the city of Ponta Grossa is complicated; there is urbanization in very rough terrain, 

which may have influenced the unexpected behavior of the tool. 

The Lee Salee metric, which is related with the spatial accuracy of the model, 

was above 0.5 and lower than 0.7. This might be considered an average result, but it 

was lower than expected. The Compare metric, which evaluates the amount of pixels 

modeled, had lower results than the Lee Salee, staying between 0.4 and 0.6. 

In this work the LeeSalee metric was used in the calibration process, as 

indicated in the SLEUTH manual, but it is interesting to mention that the SLEUTH also 

has an alternative metric that can be used in the calibration process called the optimal 

SLEUTH metric (OSM). It was created by Dietzel and Clarke, 2007, and is based on 

several metrics of control_stats.log (population, edges, clusters, slope, x-mean, y-

mean and compare) (HUA et al., 2014). 

 The simulations where only the excluded areas were altered produced some 

of the worse results. When the model simulates the city, excluded pixels are ignored 

and skipped. But, when the model calculates statistics and results, these pixels count 

normally, as can be seen in Chart 3, which presents parts of the SLEUTH algorithm.  

 
Chart 3 - Spread and Leesalee algorithm 

Spread code 

1 
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static BOOLEAN spr_urbanize(int row, int col, GRID_P z, GRID_P delta, 

GRID_P slp, GRID_P excld, SWGHT_TYPE * swght, PIXEL pixel_value, int 

*stat){ 

   char func[] = "spr_urbanize"; 

   {...} 

   if (excld[OFFSET ((row), (col))] < RANDOM_INT (100)){ 

      {...} 

      stats_IncrementUrbanSuccess(); 

   }else{ 

      stats_IncrementEcludedFailure(); 

   } 

   {...} 

   } 

Leesalee code 

1 

 

2 

static void  stats_compute_leesalee (GRID_P Z, GRID_P urban, double 

leesalee){ 

   {…} 

   for (i = 0; i < mem_GetTotalPixels (); i++){ 
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      if((Z[i] != 0)||(urban[i] != 0)){ 

         the_union++; 

      }if((Z[i] != 0)&&(urban[i] != 0)){ 

   intersection++; 

      }} 

   *leesalee = (double)intersection/the_union; 

   {…} 

   } 

Source: adapted from the SLEUTH algorithm 

 

This behavior was not observed in the SLEUTH documentation, and in any 

text read during the survey. 

Prediction values were very low in all simulations, and the number of generated 

urban pixels does not fit the reality. Ponta Grossa has very distinct characteristics of 

relief. A counter example, that would support this idea, would be the cities of: 

 Dhaka City (PRAMANIK; STATHAKIS, 2016) which had Diffusion 1, Breed 

36 , Spread 100, Slope 1 and RG 56; in this city it was used the OSM metric; 

 Mashad City, with Diffusion 7, Breed 98, Spread 97, Slope 1 and Road 

Gravity 90 (RAFIEE et al., 2009) ; 

 Houston (OGUZ, 2004) had a Diffusion of 1, Breed 3, Spread 100, Slope 22 

and RG 17; it was used the LeeSalee metric to define the best results in the 

calibration process. 

These cities were simulated in other studies, and the resulting coefficients 

were higher than those of Ponta Grossa, especially the Spread. In these cities 

simulation, the roads layer was less dense and the relief was significantly different. In 

Figure 33, the Slope layer from Ponta Grossa is being compared with the probable 

Slope used for these projects. Observing the images, is possible to see that Ponta 

Grossa Slope has more sudden changes of color, which means the slope is not regular 

and drastically changes in the area, while in the other images the slope is more regular, 

as some colors dominate the image. 
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Figure 33 - Ponta Grossa, Dhaka, Mashad and Houston relief 

 

Source: Dhaka city (PRAMANIK; STATHAKIS, 2016); Ponta Grossa, Mashad 

and Houston were download from Earth Explorer and transformed using QGIS 

Analyzing the log, it can be perceived that the self modification parameters 

were constantly used to reduce the spread coefficient, which resulted in very low 

values.  

Observing Ponta Grossa city maps, it is possible to see that the city grows at 

least 2 thousand pixels each year, and SLEUTH results are not comparable with the 

reality. Observing the log, the model grew approximately 3 thousand pixels in 30 years, 

but in the input data is possible to see that the urban area grew about 80 thousand 

pixels. Besides this, the generated pixels had a low probability rate and are not being 

modeled in the right places as presented in chapter 6.  

In an attempt to explain the results, some characteristics of the data can also 

be brought into question. The time interval used in this project was shorter than the 

majority of the experiments in the references. The urbanized portion of the images was 

small, corresponding to approximately 8% in 2017. The excluded part occupies almost 

40% of the map. In the input files of the demo that comes along with SLEUTH to test 
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the model, the urban layer of the last year available (1990), also have a small portion 

of pixels, about 10%, however the excluded areas embrace less than 11% of the map. 

The urbanized regions of Ponta Grossa appear in disorganized patterns 

instead of a single mass. The road network used as input was denser than what was 

observed in other experiments, which were limited to highways. However, nothing in 

SLEUTH documentation indicates that the use of more detailed road information would 

lead to errors. Lastly, the Land Use layer was not used, although it is not a mandatory 

input, it could have helped in the calibration process and in the sensibility of the model. 

After the execution of the simulations, it was possible to realize that the best 

kind of approach depends on the objective of the study. The subdivision approach is 

interesting to study a region that shows different, varying behaviors on historical maps. 

It must be noted that this is a time-consuming process. The calibration process, plus 

the prediction, extended for about 40 hours.  

The usage of SLEUTH could be simplified or automated in some points. The 

calibration process could be automatic, since the setup of parameters follows simple 

rules based on tables of results. As SLEUTH uses the scenario file to assist in defining 

the model execution parameters for each calibration phase, this same file could be 

adapted so that the parameters of all calibration phases were informed at a single time. 

A sort feature could be added to the model, making it possible for all phases to be 

executed automatically, without intervention, saving time.  

In Ponta Grossa city, it was possible to observe in the results some 

peculiarities, mainly in the subdivision approach, as the greater growth of subarea 2 in 

the predict phase. Among the approaches, the subdivision had better results in the 

metrics and number of modeled pixels. However, the prediction results in all 

approaches were very close, in all simulations, regardless of type used. Therefore, the 

time spent in the calibration is not justified by the model results. This kind of approach 

would be more interesting if less time was demanded, such as creating of a new 

exclusion layer, serving to define regions to be ignored both by the urbanization 

processes and statistics calculations.  
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7 CONCLUSION 

Urban simulation is not a simple task. City processes include complex patterns 

and random behaviors that can be nearly chaotic. Simulating city aspects also involves 

qualitative information. The historical context can be important information to perform 

a simulation; the development of a characteristic over the years is essential to 

understand and to analyze the city behavior. 

It is not difficult to understand why Cellular Automata models are widely used 

in urban simulation. It has the ability to create environments with complex patterns, 

being a clever choice to approximate city behavior. Besides that, they are quite simple 

to use and allow modifications to better fit the characteristics of the system being 

studied. 

SLEUTH is a popular CA model used to simulate city growth. It is reasonably 

easy to use but requires historical data that may not be readily found. In this project 

the preparation of maps took a reasonable time, as the information was dispersed in 

several sources. In the present study, the city administration did not dispose of 

historical maps. Some images had to be prepared by hand, from satellite images. This 

is a time consuming procedure, which must be executed with care to avoid errors. 

The regionalization of the city into regions was a matter of some debate, as 

there are infinite possibilities and no established rules to do that. In the present project 

it was created a subdivision based on the highways and streets, because it was not 

possible to find official regionalization which would satisfy the research needs. The 

regionalization needed to be consistent, and each of the area should have autonomy 

and capacity for growth and flow by itself. Between the characteristics pursued, it was 

necessary that each region had markets, pharmacies and banks. Also it was thought 

about the city culture, and how the population identifies some areas, and the best 

known neighborhoods for each region. In the process, some options were considered, 

as dividing the city in four pieces or by total area. But, the regionalization based on the 

streets and highways seemed the best choice, because by using this option the 

subareas had relatively good size and the necessary infrastructure. In addition, to 

preserve the features sought, the city center was added in all subareas to guarantee 

autonomy, and some areas are present in more than one subarea, to preserve the 

neighborhoods of the group.  
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The results obtained after performing the calibration phases, and executing 

the prediction, were different from what was expected. Until the final calibration 

process, the values of coefficients seemed to reflect the reality, matching the way the 

city grows. Road Gravity displayed, mostly, erratic values, but the analyzed city grows 

without a defined pattern, which may have been the reason for the model confusing 

results. 

The metrics used had low to median values, never exceeding 70%. Analyzing 

the values in the avg.log, it is possible to observe that the simulated area is not 

comparable with the actual city growth.  

Ponta Grossa is growing steadily, as can be observed in the input data, but 

the prediction coefficients derived from the forecasting were low in all the simulations 

performed. The model prediction for 2017 did not fit the way the city expands. The 

calculated growth was less than 10% of the real values and the modeled pixels were 

mostly in the wrong places. 

Among the simulations, the results were all pretty close. Overall, the worst 

results were obtained with the Excluded approach. By comparing the results of all the 

simulation approaches, it seems that the complete simulation is the best choice. This 

because the subdivision approach had better results, but the time consumed was too 

long. While overall results did not correspond to the volume of expansion of the city, 

the experiments using different parameters showed that the model would be able to 

follow the grow patterns shown in historical data. 

SLEUTH was able to simulate some characteristics of Ponta Grossa city, but 

not to attain quantitative results. This may have happened for several reasons.  

It would be interesting to study the city land use, categorizing what a particular 

place was used for over time. This information could make possible to analyze how the 

transitions between rural and residential happen, the reaction of a region after the 

installation of a new industry, and how a new commercial spot impacts in the area 

where it is applied. These studies could analyze the attraction and repulsion forces, 

and track the development of commercial/residential areas. From this kind of 

information, could be possible to understand what makes the city grow more in one 

place than in another and analyze how the land use impacts on the city behavior and 

growth over time. For this study, CA models would also be a good choice, given the 

form they work.  
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Urban simulation and specifically the urban growth are tricky subjects. To be 

able to understand how they work it is necessary to study different aspects of a city 

separately, and merge them to see how they work together. The spatial spread, is only 

one of the elements that influence in how the city growth. This subject involves several 

other factors, as real state, land use transitions and industrial development. Thus, only 

studying spatial growth may not be sufficient for a model understand and define the 

patterns of a city. Therefore, in order to truly understand the growth pattern of the city, 

and obtain results closer to the reality, other studies contemplating the different 

aspects of urban growth must be carried out to be analyzed together with the spatial 

growth. 
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Layers development 

 

ROADS 

 After installing the OpenLayers plug-in, in the Quantum GIS software, go to 

the option Web > OpenLayers plug-in > OpenStreetMap > OpenStreetMap and 

inform the latitude and longitude data (Figure 35) to add the street map in the 

layers.  

 
Figure 34 - Ponta Grossa latitude and longitude 

 

Source: OpenStreetMap 

 To add the administrative city borders, go to Layer > Add Layer > Add Vector 

Layer and choose the shape file downloaded from the IBGE site.  

 After arranging the image with the necessary size, using the option File > Save 

Screen as Image, choose the .jpg option.  

 Open the Photoshop. 

 Create a new project and add the .jpg derived from QuantumGIS as a new 

layer. 

 Select the white color using the option Select > Color Range and erase the 

selected parts.  

 Create a new layer and paste in that the satellite image from 2014 and spatially 

fit the layers as Figure 35.  
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Figure 35 - Roads vector over the satellite images 

 

Source: Adapted from Google Earth and OpenStreetMap 

 Create a new layer, and draw the missing streets using the Line Tool.  

 Select all shapes created, click with the right mouse button and select the 

option Group into a New Smart Object.  

 Select the new object and use the mouse right button to choose the option 

Rasterize Layer. 

 Selecting both roads layers, click with the right mouse button and select the 

option Group into a New Smart Object.  

 Click with the right mouse button in the new object and select the option 

Rasterize Layer. 

 Erase the streets without connection and out of the city border. 

 To have layers with different colors (given its importance) create a new layer. 

 Overlap the roads vector with this layer, and using the Line Tool draw the 

streets of interest.  

 Group all the shapes created by the line tool selecting then and using the 

option Group into a New Smart Object.  

 Select the new object and use the option Rasterize Layer.  

 Paint the streets with the respective shade. 

 Select the created roads layers, and using the mouse right button chose the 

Group into a New Smart Object option. 

 Click in the object with the mouse right button and chose Rasterize Layer. 

 To create the historical layers duplicate the roads layers from 2014. 
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 Add a new layer, and paste the satellite images from the historical year behind 

the roads layers. 

 Using the Eraser Tool, erase the streets that are not in the satellite image. 

 Create a new layer, and paint it in black, put it behind the roads layer. 

 Save the project. 

 Keep just the black layer and the roads for the year being saved, hide the 

others. 

 Transform the image color using the menu Image > Mode > Grayscale (it may 

keep just one layer and erase the others). 

 Save the image as .gif. 

 Choose the option Edit > Redo Grayscale. 

 Repeat the process to save the other layers. 

 

URBAN 

 After downloading the images from the selected source (Google Earth and 

INPE), open the Photoshop. 

 Create a new layer for each satellite image available for the years being 

developed and paste the satellite images (Figure 36). 

 

Figure 36 - Satellite Layers 

 

Source: Adapted from Google Earth and INPE 

 Fit the images spatially when necessary. 
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 For assistance, create new layers for the previous and subsequent years and 

paste the satellite images. 

 Create a new layer over the satellite images. 

 Zoom in on the images. 

 Detect the urban areas and color then using the Brush Tool in the empty layer. 

 When reach to areas that are difficult to identify, use the previous and 

subsequent year’s layers. 

 Repeat the process for all the needed years using a different color for each 

one. 

 Starting in the first year develop, using the layers overlap, verify the borders of 

each spot. 

 Paint the spots of all the years in white. 

 Create a new layer, and paint it in black, put the layer behind the urban layers. 

 Save the project. 

 Keep just the black layer and the urban spots for the year being saved, hide 

the others. 

 Transform the image color using the menu Image > Mode > Grayscale (it may 

keep just one layer and erase the others). 

 Save the image as .gif. 

 Choose the option Edit > Redo Grayscale. 

 Repeat the process to save the other layers 

 

EXCLUDED AREAS 

 After downloading the Conservation Unit section from the Director Plan, open 

Photoshop. 

 Create a new layer, and paste a satellite image for any year. 

 Create a new layer and paste the conservation unit image. 

 Fit the images spatially, using transparency in the conservation unit image 

(Figure 37). 
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Figure 37 - Conservation Unit image over satellite image 

 

Source: Adapted from Google Earth and IPLAN 

 Create a new layer. 

 Crop the conservation areas from the conservation unit image. 

 Paste in the new layer. 

 Paint the pasted area in white. 

 Select the area outside the city borders. 

 Create a new layer. 

 Crop the area. 

 Paste in the new layer. 

 Paint the pasted area in white. 

 Create a new layer, and paint it in black, put the layer behind the created 

layers. 

 Save the project. 

 Keep just the black layer and both created layers visible, hide the others. 

 Transform the image color using the menu Image > Mode > Grayscale (it may 

keep just one layer and erase the others). 

 Save the image as .gif. 

 

SLOPE AND HILLSHADE 

 After downloading four tiff images from Earth Explorer, open the Quantum GIS.  

 Create a new project. 

 Add the images. 

 Correct the scale by 11120 in the Scale ratio vertical units to horizontal box as 

is advised in the Quantum GIS manual. 

 Add the IBGE administrative borders shapefile. 
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 Go to Raster > Analysis > DEM (Terrain models). 

 Select the Hillshade option. 

 Click in OK. 

 After arranging the image with the necessary size, using the option File > Save 

Screen as Image, choose the .jpg option.  

 Go to Raster > Analysis > DEM (Terrain models). 

 Select the Slope option. 

 Choose the Percentage option. 

 Click in OK. 

 After arranging the image with the necessary size, using the option File > Save 

Screen as Image, choose the .jpg option.  

 Open the Photohosp 

 Create two new layers and paste the images for the Slope and Hillshade 

 Create a new layer and paste a satellite image. 

 Spatially fit the layers in the satellite image using the layer transparency 

(Figure 38). 

 
Figure 38 - Slope over satellite image 

 

Source: Adapted from Google Earth and Earth Explorer 

 Save the project. 

 Keep just the Slope layer visible, hide the others. 

 Transform the image color using the menu Image > Mode > Grayscale (it may 

keep just one layer and erase the others). 

 Save the image as .gif. 

 Choose the option Edit > Redo Grayscale. 

 Repeat the process to save the Hillshade. 
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